About this User’'s Manual

This user’s manual is designed to let you easily find the information you need to
get the most from your notebook.

e Introduces you to the features of your notebook.

e Gives you the useful details on using your notebook.

e Tells you how to look after your notebook, whether at home or traveling.
e Talks about Express Card peripherals and how to use them.

e Goes into more detail about power management and explains how to
conserve power while on the move.

e Introduces you to BIOS, the nervous system of your notebook, and how to
change its fundamental settings.

There is no need to read the manual from the beginning to end. Simply find your
way to the section that interests you using the table of contents, or browse
through the manual.

You will come across the following icons in this manual:

;Q_J Helpful pointers and tricks to get more from your notebook

To help you note and avoid possible damage to your notebook’s hardware
or software, or loss of your work

n Points out possible damage to property, personal injury or death

Information in this document is subject to change without notice.

© Compal Electronics, Inc. 2008. All rights reserved.

Trademarks used in this document: Microsoft and Windows are registered
trademarks of Microsoft Corporation.

Other trademarks and trade names may be used in this document to refer to
either the entities claiming the marks and names or their products.
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Safety Instructions

Safety Instructions

Use the following safety guidelines to help protect yourself and your notebook.

General Warnings

Do not operate your portable computer for an extended period of time with the base
resting directly on your body. With extended operation, heat can potentially build
up in the base. Allowing sustained contact with the skin could cause discomfort or,
eventually, a burn.

Do not attempt to service the computer yourself. Always follow installation
instructions closely.

To avoid personal injury from electric shock or fire:

- Completely power down the computer when replacing memory modules,
cleaning the computer, its components, or chassis, or performing operations
requiring similar steps. To do this, first turn the power off at the power switch,
remove the battery, and then disconnect the AC adapter from the electrical
outlet or from any other type of external power source, such as an external
battery.

- Do not operate the computer near water, for example, near a bathtub, kitchen
sink or laundry tub, in a wet basement, by a swimming pool, or in the rain.

- Do not connect or disconnect any cables or perform maintenance or
reconfiguration of this product during an electrical storm.

- Avoid using the wired modem or LAN during an electrical storm, as a remote
risk of electric shock from lightning exists.

- Do not push objects into the air vents or openings of your notebook or
accessories. Doing so can short out interior components and may cause fire or
electric shock.

- When installing memory modules, ground you by touching a grounded
conductive surface, such as a device with a grounded plug. Avoid touching the
pins and leads on the memory module or internal circuitry of the computer.

When setting up the computer for work, place it on a level surface.
Handle components with care. Hold a component such as a memory module by its
edges, not its pins.

If the battery pack leaks and the fluid get in your eyes, do not rub them. Instead,
rinse your eyes with clean running water and immediately seek medical attention.
Otherwise, eye injury may be resulted.
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If acid leaking from the battery pack contacts your skin or clothing, immediately
wash it away with the running water. Otherwise, the skin inflammation may occur.

Operate the computer at the recommended temperature range of +5°C to +35°C
(+41°F to +95°F). Store it at a temperature of -20°C to +60°C (+4°F to +140°F).

Your notebook shipped with the plastic dummies installed in PCMCIA or Express
slot. Dummies protect unused slots from dust, metal object, or other particles. Save
the dummy for use when no PCMCIA or Express Card is installed in the slot.

Power Cord & Adapter Warnings

See the installation instructions before connecting to the power supply.
Use only the power cord indicated in this manual.

Power cord sets for use in other countries must meet the requirements of that
country. Use the appropriate AC adapter and power cord for your locale.

If you use an extension cord with your AC adapter, ensure that the total ampere
rating of the products plugged into the extension cord does not exceed the ampere
rating of the extension cable.

When using your power cord, make sure to position it around objects so it will not
be cut or punctured.

When you disconnect a cable, pull on its connector on its strain relief loop, not on
the cable itself. As you pull out the connector, keep it evenly aligned to avoid
bending any connector pins. Also, before you connect a cable make sure both
connectors are correctly oriented and aligned.

Be sure that nothing rests on your AC adapter’s power cable and that the cable is
not located where it can be tripped over or stepped on.

Use only the AC adapters that are approved for use with this computer. Use of
another type of adapter may risk fire or explosion.

Before you connect the computer to a power source, ensure that the voltage rating
of the AC adapter matches that of the available power source.

- 115 V/60 Hz in most of North and South America and some Far Eastern
countries such as South Korea and Taiwan.

- 100 V/50 Hz in eastern Japan and 100 V/60Hz in western Japan.

- 230 V/50 Hz in most of Europe, the Middle East, and the Far East.

- If you use an extension cable with your AC adapter, ensure that the total
ampere rating of the products plugged in to the extension cable does not
exceed the ampere rating of the extension cable.
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Place the AC adapter in a ventilated area, such as a desktop or on the floor, when
you use it to run the computer or to charge the battery. Do not cover the AC adapter
with papers or other items that will be reduced to cool; also, do not use the AC
adapter while it is inside a carrying case.

Disconnect power cords and cables by grasping the connector, not by pulling on
the cable itself. As you pull out the connector, keep it evenly aligned to avoid
bending any connector pins. Before you connect a cable, please make sure both
connectors are correctly aligned.

To remove power from the computer, turn it off, remove the battery, and disconnect
the AC adapter from the electrical outlet.

Battery Pack Warnings

Do not carry a battery in your pocket, purse, or other container where metal objects
(such as car keys) could short-circuit the battery terminals. The resulting excessive
current flow can cause extremely high temperatures and may result in damage from
burns.

Danger of explosion may occur if battery is incorrectly replaced. Replace only with
the same or equivalent type battery recommended by the manufacturer.

Do not dispose of batteries in a fire. They may explode. Check with local authorities
for disposal instructions.

Do not uses or leave the battery pack near a heat source. Heat can melt the
insulation and damage other safety features, possibly leading it to leak acid,
overheat, emit smoke, burst and/or ignite.

Do not immerse the battery pack in water or allow it to get wet. Its protective features
can be damaged. Abnormal chemical reactions may occur, possibly leading it to
leak acid, overheat, emit smoke, burst and/or ignite.

Do not crush, disassemble, puncture, or incinerate the short external contacts of a
battery pack.

Do not connect the positive (+) and negative (-) terminals with a metal object such as
wire. Short-circuiting may occur leading the battery pack to leak acid, overheat, emit
smoke, burst and/or ignite.

Do not use an apparently deformed or damaged battery pack, which may leak acid,
overheat, emit smoke, burst and/or ignite.

If the battery pack leaks, gives off a bad odor, generates heat, becomes discolored
or deformed, or in any way appears abnormal during use, recharging or storage,
immediately remove it from the computer or charger and stop using it.
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Battery Pack Disposal

- Dispose of the lithium ion battery packs at approved disposal sites only. To locate an
appropriate site, contact the solid waste disposal officials where you live or look for a
rechargeable battery recycling website that lists disposal locations near you.

- Do not dispose of battery packs in a fire, throw them in a trash receptacle, put them
in a recycling bin not intended for their disposal, or otherwise discard them in a
manner that may result in their being hazardous to the environment.

Internal Modem Warnings

CAUTION: When using your telephone equipment, basic safety precautions should
always be followed to reduce the risk of fire, electric shock and injury to persons,
including the following:

- The modem cable you connect to your notebook should have a minimum wire size
of 26 AWG (American wire gauge) and an UL-compliant RJ-11 modular plug.

- Avoid using a telephone (other than a cordless type) during an electrical storm.
There may be a remote risk of electric shock from lightning.

- Do not use the telephone to report a gas leak in the vicinity of the leak.

- Do not plug a modem connector (RJ-11) into a network connection (RJ-45). This
may damage the connector.
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Federal Communication Commission PART 68 Warning

This equipment complies with Part 68 of the FCC rules. Located on the bottom side of
the modem is a label that contains, among other information, the FCC Registration
Number and Ringer Equipment Number (REN) for this equipment. Upon request, you
must provide this information to your telephone company.

If your telephone equipment damages the telephone network, the local telephone
company may temporarily discontinue your service. If possible they will notify you in
advance. But, if advance notice is not practical, you will be notified as soon as possible.
You will also be informed of your right to file a complaint with the FCC.

Your telephone company may make changes to facilities, equipment, operations, or
procedures that could affect the proper functioning of your equipment. If they do, you
will be notified in advance to give you an opportunity to maintain uninterrupted
telephone service.

If this equipment should fail to operate properly, disconnect the equipment from the
phone line to determine if it is causing the problem. If the problem is with the
equipment, discontinue use and contact your dealer or vendor.

TBR21

This equipment has been approved [Council Decision 98/482/EC — “TBR21"] for
pan-European single terminal connection to the Public Switched Telephone Network
(PSTN). However, due to differences between the individual PSTNs provided in
different countries, the approval does not, in itself, give an unconditional assurance of
successful operation on every PSTN termination point. In the event of problems, you
should contact your equipment supplier in the first instance.




Modem Regulatory Notice

Important Safety Instructions

Read these instructions carefully and save them for reference in future.

1.
2.

10.

11.

Follow all warnings and instructions reminded you about this product.

Unplug this product from the wall outlet before cleaning. Do not use liquid

cleaners or aerosol cleaners. Use a damp cloth for cleaning.

Do not use this product near water.

Do not place this product on an unstable cart, stand, or table. It may be broken to

cause some serious damage of itself.

Slots and openings in the cabinet and the back or bottom are provided for

ventilation. To ensure reliable operation of the product and to protect it from

overheating, and also do not block or cover these openings. Avoid placing the

product on a bed, sofa, rug, or similar surface to prevent from blocking these

openings. This product should never be placed near or over a radiator or a heat

register, or in an enclosure unless proper ventilation is provided.

This product should be operated from the type of power indicated on the marking

label. If you are not sure the type of power available, consult your dealer or local

power company.

Do not allow anything to rest on the power cord. Do not locate this product where

people will step on the cord.

If an extension cord is used with this product, make sure that the total ampere

rating of the equipment plugged into the extension cord does not exceed the

extension cord ampere rating. Also, make sure that the total rating of all products

plugged into the wall outlet does not exceed the fuse rating.

Never push objects of any kind into this product through cabinet slots as they may

touch dangerous voltage points or short-out parts that could result in a fire or

electric shock. Never spill any kind of liquid on the product.

Do not attempt to service this product by yourself. As opening or removing covers,

you will be exposed to the dangerous voltages or other risks. Refer all servicing to

qualified service personnel.

Unplug this product from the wall outlet and refer servicing to qualified service

personnel under the following conditions:

a. When the power cord or plug is damaged or frayed.

b. As liquid is spilled into the product.

c. The product is exposed to rain or water.

d. If the product does not operate normally when the operating instructions are
followed, adjust only those controls that are covered by the operating
instructions. Improper adjustment of other controls may result in damage and
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will often require extensive work by a qualified technician to restore the
product to normal condition.

e. The product has been dropped or the cabinet has been damaged.

f.  The product exhibits a distinct change in performance, indicating a need for
service.

EMC Regulatory Information

This product is designed and tested to comply with the following related EMC
(Electromagnetic compatibility) standards.

FCC Notice

“Declaration of Conformity Information”

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.

This equipment generates uses and can radiate radio frequency energy .If the
equipment is not installed or used in accordance with the instructions; it may cause
harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the
interference by one of following measures:

e Reorient or relocate the receiving antenna.
e Increase the separation between the equipment and the receiver.

e Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

e Consult the dealer or an experienced radio/TV technician for help.
This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions:

(1) This device may not cause harmful interference.
(2) This device must accept any interference received, including interference that
may cause undesired operation.
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Canadian Notice (Canada Only)

This digital apparatus does not exceed the Class B limits for radio noise emis-
sions from digital apparatus as set out in the Radio Interference Regulation of the
Canadian Department of Communications.

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conformé a la norme NMB-003
du Canada.

Norwegian Notice (Norway Only)

For Class | equipment: In Norway, it intend to be connected to CABLE DISTRIBUTION
SYSTEMS, the screen of a coax cable is required to be galvanic isolated from the
protective earth. The Norwegian text is that “Ma kun tilkoples kabel-TV nett via
galvanisk isolator.”

CE Notice (European Union)

EU Declaration of Conformity

The product conforms to the following standards:

Supplementary Information: *The product complies with the requirements
of the Low Voltage Directive 73/23/EEC and
the EMC Directive 89/336/EEC and/or the
R&TTE Directive 1999/05/EEC.”

This product is carrying the CE-Mark in accordance with the related European
Directives.

BSMI Notice (Taiwan Only)

Most Compal computer products are classified by the Bureau of Standards,
Meteorology and Inspection (BSMI) as Class B information technology equipment
(ITE).

"é This (marked on the product) indicates the product complies with the
BSMI standard.

®

R 31139
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Specifications

Specifications

CPU
. Intel Merom-Celeron M,
- Santa Rosa Generation
- Montevina Generation
Chipset
o SIS M672/M672FX+ SiS 968
- 667 MHz FSB DDRII support
- Merom-base Celeron processor support
Memory
. No on board memory
o Supports DDR-11 667MHz
. Two SODIMM with 1GB/2GB modules
. Easy upgrade for two SODIMM
o Max.4GB
Display
. Support 15.4” WXGA (1280 x 800)
Camera
J Camera 1.3M/2.0M Pixel CMOS via USB2.0 interface
Keyboard

. 86 keys support with 101/102 key emulation without stick-point
. Windows key; Application key

. Standard pitch,3.0mm travel length

. Multi-Language support

Hard Disk Drive (HDD)
o 9.5mm,2.5”S-ATA HDD support with 80/120/160/250GB

(5400rpm)capacity

. 9.5mm,2.5”S-ATA HDD support with 120/160GB
(7200rpm)capacity

. Easily removable

Optical Disc Drive (ODD)
o Fixed 12.7mm height with SATA interface




Specifications

. Combo(CD-RW/DVD-ROM) (24x/24x/8x/24x)
DVD-RAWY/-R/-RW readable

. DVD Super-Muti (DVD-RAM/-R/-RW/+R/+RW)
- 8X Write

- Support Double-layer Recording is required

Pointing Device

. Touch Pad with two buttons

Media card reader
. 3-in-1 Card Reader (SD,MMC,MS)

I/O Ports
. Express Card 34/54mm x 1
. RJ-45 jack x 1
. RJ-11 jack x 1 (Option)
. Headphone-out x 1
. Microphone-in x 1
. 3-in-1 Card Reader x 1
o Power USB ports x 3
. RGB:VGA port x 1, 15 pins
. DC-in jack x 1

. Kensington lock x 1
. Internal digital microphone x 1
WLAN

) 802.11 b/g,via PCI-E interface
Modem
. Internal Modem with MDC 1.5 solution V.92/56K bps;V.90/56K bps

Bluetooth
. Bluetooth Ver.2.1 module with USB2.0 interface

Mini Card
. 1 Mini card slot for WLAN module

Control Buttons

° Power button x 1
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Specifications

o Power USB x 1
. Magnetic lid swith control for system standby/wakeup or suspend/resume

o Program DJ x 1

AC Adapter
o Universal AC adapter. 100-240V AC, 50-60Hz
- 65W with 19V DC
- 3 pin 240V AC cable
Options
. Internal Modem with MDC 1.5 solution V.92/56K bps;V.90/56K bps
. Camera 1.3M/2.0M Pixel CMOS via USB2.0 interface
J Bluetooth Ver.2.1 module with USB2.0 interface
System Status Indicators(Ul spec)
. 1 LED for Power Button(Blue)
. 1 LED for Power USB on(Blue)
. 1 LED for Compal AP: Program DJ(Blue)
. 1 LED for Power Status(Blue)
. 1 LED for Battery status (Charging/Full/L1/L2) (Blue/Amber)
. 1 LED for HDD activity (Blue)
. 2 K/B indicators:Caps Lock (Blue) and Num Lock (Blue)
. 1 LED for Wireless LAN & Bluetooth (Blue/Amber/Purple)

PCI-Express card
. 34/54mm PCI Express card x 1

Graphics Chip
) SiS M672/M672FX,256MB share from system memory
o SiS 307ELV for LVDS

. Realtek ALC268

. 2 channel HD Audio

. Compliant with Universal Audio Architecture

. 95dB SNR DACs /90dB SNR ADCs can meet Vista Premium requirement
. Microphone-in and headphone-out

. Two stereo 1.5W speakers with chamber
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o Volume control:Hot-key control for Windows
User Keys
o Control buttons for Power USB

- Power USB (Workable in system off mode)

Killer Swich
. YES, for Wirless LAN/Bluetooth
Battery

. 6-cell Li-On, 18650 type, 4400mAh (Standard)
. 6-cell Li-On, 18650 type, 4800mAh (Option)
. 4 hours to complete battery charge from energy empty to full when system off
. Life Cycle: 70% Design Capacity after 300 Cycles in 25degreeC
Software
. Phoenix First BIOS
. Suspend to DRAM/HDD
o Security:
- Power-On Password,Supervisor Password
- HDD password
- USB memory Boot support
o Support SMBIOS 2.3, PCI2.2
o Support PXE
o Wake on LAN from S3
. Wake on LAN from S4 in AC mode
Application
. Program DJ (XP/Vista)
o WOW Audio (XP/Vista)
. WOW Video (XP/Vista)
o Smart Watchdog (XP/Vista)
. Green Charger (XP/Vista)
) Entrance Guard (Vista)
. Safety Guard (Vista)
o Meeting Secretary (Vista)
0oS
o Windows Vista (32bit) support
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Security

Windows XP (32bit) support

Kensington lock

Regulatory

EMI: FCC-B,CE,CCC,C-Tick,vVCCI,BSMI
Safety: Compliant to UL/CSA, TUV,CB
PTT. FCC-Part 68,CTR 21

MDAZ2005 Compliant

WHQL LOGO(XP/Vista Basic)

Energy Star

Xiv






Chapter 1

Introducing Your Notebook




1 Introducing Your Notebook

1.1 Front Side

The following picture shows the front side of your notebook.

) - o : o)
1
) 11
3 12
13
4
5
- )
6 E==—=i
7
8
1 Display 8 HDD LED
2 Power USB Button 9 Touch Pad Buttons
3 Power Button 10 Camera
4 || Keyboard 11 || Smart Key Button
5 Bluetooth/Wireless switch 12 Num Lock LED
6 || Power LED 13 || Caps Lock LED
7 Battery LED
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1 Introducing Your Notebook

1.1.1 Display
Your display is either a 15.4” COLOR TFT WXGA, LCD.
1.1.2 Power USB Button

ot The laptop is equipped with a power USB function, which allows you to
increase the power output when charging an external USB device, such as a
mobile phone or PDA.

You can charge external USB devices with power cable connected when the
laptop is powered off, but this button must be pressed in order to do so.

1.1.3 Power Buttons

o [ =)
()  Press to turn your notebook on. For more on
i F2
power settings, see 0 7.1 Power m @
Management (Vista).

& Windows Vista, which comes preinstalled, goes into the shutdown sequence
automatically if you press the power button while on.

In Windows Vista, you can configure this in Control Panel > System and
Maintenance or Hardware and Sound > Power Options > Change plan settings >
Change advanced power settings.

1.1.4 Keyboard

The keyboard includes a numeric keypad and the Microsoft® Windows® logo key.
See 0 2.3 Keyboard and Touch Pad (Vista) for details on using keyboard shortcuts.

1.1.5 Bluetooth/Wireless Switch
The following is two state of kill switch

1: kill switch On:

When users press Fn+F2, AP will be showed. At this time, User can turn on/off which
Wireless LAN and Bluetooth.

2: kill switch Off:

In this status, when users press Fn+F2, AP will be show user that can not turn on Wireless
LAN and Bluetooth.

1.1.6 Power LED (Blue)

Power LED and Suspend LED indicate the systems power states by user combinations
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1 Introducing Your Notebook

1.1.7 Battery LED (Blue/Amber) (T=)

Battery states LED is one dual-color LED indicator both of Blue and Amber color.

1.1.8 HDD accessing state Blue LED (@)

Reflect the activities of Blue Led.
Note: LED is controlled directly by hardware.

1.1.9 Touch Pad Buttons

The left and right touch pad buttons perform the same functions as the left/right buttons of a
standard mouse.

1.1.10 Camera (option)

The built-in camera supports a 1.3/2.0 mega pixel CMOS web camera.
1.1.11 Smart Key Button

LED (Blue color) blinking once while pressing Smart Key Button.
1.1.12 Num Lock LED (Blue)

Number Lock LED (Blue): Number Lock State of Keyboard.
1.1.13 Caps Lock LED (Blue)

Caps lock LED (Blue): Caps Lock State of Keyboard

NOTE: In normal mode (Cursor and Num function are disable), When user press Hot Key,
the Cursor LED will be on. When users press Hot Key, the Cursor LED will be off.
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1 Introducing Your Notebook

The flashing Power On LED indicates your notebook is in standby mode.

1

Microphone Jack

2

Headphone Jack
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1 Introducing Your Notebook

1.2 Right Side

Power USB Ports

Optical Disc Drive

AC Adapter Connector
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1 Introducing Your Notebook

1.2.1 Power USB Ports

When you press Power USB button under off mode, you can charge external
USB devices with power cable connected.

"@ USB is a peripheral expansion standard that supports data-transfer rates up to

B 480 Mbps. USB peripherals have a single standard for cables and connectors. You
can install and remove USB devices while the computer is on. This is called “hot
swapping”.

1.2.2 Optical Disc Drive

The optical disc drive provides a means for you to import/export data into/from your
notebook. Depending on the configuration of your notebook, you may either be able to
record or play CDs/DVDs.

1.2.3 AC Adapter Connector

=sem UsSe this connector to attach the AC adapter to your notebook. You can
Wmm®  connect an AC adapter when your notebook is switched on or off.

While the AC adapter works with electrical outlets worldwide, power connectors
and power strips vary by country. Ensure you use a compatible cable or correctly
connect the cable to the power strip or electrical outlet. Failure to do so may
cause fire or damage to equipment.

1-6



1 Introducing Your Notebook

1.3 Left Side

The following picture shows the left side of your notebook.

1 | Kensington Lock

2 || RJ-11(Option)

3 || Wireless Kill switch

4 || D-SUB

5 || RJ-45

6 || 3in1 Card Reader

7 | Express Card

1.3.1 Kensington Lock

A Kensington Security Slot is a small, metal-reinforced hole found on almost all small or
portable computer and electronics equipment, particularly on expensive and/or relatively
light ones, such as laptops, computer monitors, desktop computers, gaming consoles, and
video projectors. It is used for attaching a lock-and-cable apparatus, in particular those from
Kensington.
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1 Introducing Your Notebook

1.3.2 Modem Jack (RJ-11)

The modem jack allows you to connect your notebook to a telephone line with
a standard RJ-11 connector.

1.3.3 Wireless Kill switch (Wireless Switch ON/OFF)

Turns the wireless communication function on or off. The wireless communication LED on
the front panel lights when the function is activated.

1.3.4 VGA Port

O] Use this port to connect an external monitor to your computer.

1.3.5 LAN Jack

[ The RJ-45 network jack allows you to connect your notebook to a local area
network (LAN).

& Be careful not to plug the telephone line into the slightly larger network connector.

1.3.6 3in 1 Card Reader

Supports one SD/MMC/MS pro card, which is used in digital still camera and various forms
of portable information equipment.

1.3.7 Express Card

Supports 34/54mm type Express Card. For more information, see 0 6.1 Express Cards.
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1 Introducing Your Notebook

1.4 Rear Side

The following picture shows the rear side of your notebook.

i
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1 Introducing Your Notebook

1.5 Bottom Side

The following picture shows the bottom side of your notebook.
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1 | Battery Pack

2 || Battery Release Latch

3 HDD Cover

4 || Battery Lock Switch

5 || Thermal Cover

6 | Memory Module Cover
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1 Introducing Your Notebook

1.5.1 Battery Pack

With a charged battery pack installed, you can use your notebook without connecting it to
an electrical outlet. For more details, see 0 7.3 Battery (Vista).

To remove the Battery Pack:
1. Pitch the Battery Lock Swich laterally (Unlock position).

2. Slide the Battery Release Latch to the left and gently pry the Battery Pack from the
computer chassis.

1.5.2 Battery Release Latch

The Battery Release Latch secures the battery pack. To release, slide the latch and then
remove the battery pack from the bay
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Chapter 2
Operating Your Notebook (Vista)




2 Operating Your Notebook (Vista)

2.1 Turning Your Notebook On and Off

2-1
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Turning Your Notebook Off
Logging Off

Adding User Accounts

Sleep Mode



2 Operating Your Notebook (Vista)

2.1.1Turning Your Notebook On

'Q‘ You can configure the computer to start from a specific drive, such as a CD-ROM,
an external floppy disk, or even an external device. See 0 9.4 The Boot Menu.

Press the power button O to turn on your notebook.

Do not turn off the computer until the operating system has loaded completely.
Turning the computer off during its initial startup will result in an error the next
time you start your notebook.

2.1.2Turning Your Notebook Off

Save and close any open files, exit any open programs.
Click Start > P > Shut Down.
Your notebook will automatically turn off after the shutdown process is finished.

Press the power button to shut down or enter sleep mode. Click Start > Control
Panel > Power Options > Choose what the power button does.

2.1.3 Logging Off

With Microsoft Windows Vista, multiple users have access to a single computer with their
own personal settings. Using their own password, each user can log on to the computer
which using their own private profile and settings.

To log off:

Save and close any open files, exit any open programs, click Start > P> > Log Off.
To switch users:

Click Start > P > Switch User.

Using Fast User Switching, programs executed by previous users remain running in the
background. This means a possible slower computer response. It may also stop multimedia
programs, including games and DVD software, from running.

'Q‘ Fast User Switching does not work if your notebook is running Windows Vista and
is a member of a computer domain or if your notebook has less than 128 MB of
memory.
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2 Operating Your Notebook (Vista)

214 Adding User Accounts

@1 Different account options are available when a computer is running Windows Vista
operating system and is connected to a domain.

With Windows Vista installed, the system administrator or a user with administrator rights
can create additional user accounts:

1. Click Start > Control Panel > User Accounts and Family Safety > User Accounts >
Manage another account.

2. When prompted, click Continue.
Click Create a new account.
4. Enter the name of the new user and choose one of the following options:

e Standard user: User can install some programs and hardware.

e Administrator: User can change all computer settings.

5. Click Create Account.
2.1.5 Sleep Mode

To find out how to conserve power using the Sleep Mode, see 0 7.1 Power Management.



2 Operating Your Notebook (Vista)

2.2 Tips for Using Windows

>
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Microsoft Windows Vista Help
Windows Desktop

Start Button

Taskbar

Notification Area (System Tray)
Recycle Bin

Control Panel

Computer
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2 Operating Your Notebook (Vista)

2.2.1 Microsoft Windows Vista Help

For Microsoft Windows Vista help, go to Start > Help and Support. The Windows Help
and Support dialog box opens.

@ Windows Help and Support @&u

Find an answer

=] ”

Windows Basics Security and Maintenance  Windows Online Help
le ¢ o
Table of Contents Troubleshooting What's new?

m

Ask someone

Use 2 Windows Remote Assistance to get help from a friend or offer help,

Post a question or search for an answer in Windows communities,

For technical assistance, contact Microsoft Customer Support enline.

+ More support options...

Information from Microsoft

1. Find your files and felders
2. Get your programs to woerk on this version of Windows
3. Update your drivers

™ Ask someone or expand your search

i3 Offline Help +
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2 Operating Your Notebook (Vista)

2.2.2 Windows Desktop

"__ 1 Depending on your notebook setup and software, your desktop may have different or
additional shortcuts. See 0 2.4 Personalizing Your Desktop for more information.
Recycle
Bin s

Start button Taskbar Notification Area
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2 Operating Your Notebook (Vista)

2.2.3 Start Button

The Start button allows easy access to your notebook’s programs.

Fiy Internet
Internet Explorer

L E-mail
i lJ_lI Windows Mail

| Welcome Center

@ Windows Media Center

E| Windows Ultimate Extras

K5W91
Documents
Pictures
Music

|u4 Windows Media Player e

B o

3531 Windows Photo Gallery

E:I._Oﬂ Windows Live Messenger Download Recent Iterns

@m Windows DVD Malker Computer

{E‘ Windows Meeting Space Network
Connect To
Control Panel
Default Programs

All Programs Help and Support

The Start menu is designed to adapt to show the programs you use most frequently. To
always keep an item on the Start menu, no matter how often it’s used, right-click the item
and click Pin to Start menu.

b puts the current session into memory and enters a low-power state ready to be resumed.

ﬁ Locks this computer

» provides options for turning off, restarting, switching users, logging off, and placing your
notebook in power saving modes.

2-7



2 Operating Your Notebook (Vista)

2.2.4 Taskbar

The Start button is on the left and the notification area on the right. Each time you open a

program; a button for it appears on the taskbar. To move between programs, simply click the
relevant button. Windows Vista groups multiple instances of the same program on a single
taskbar button if more space is needed.

Toolbars can be added to or removed from the taskbar:
Right-click an empty spot on the taskbar, and select Toolbars > choose the toolbar you
want to add.

2.2.5 Notification Area (System Tray)

The icons in this area allow quick access to programs and computer functions, including the

clock and printer status. Windows Vista hides icons that are not frequently used. Click < to
see hidden icons.

To prevent Windows Vista from hiding icons:

Right-click an empty spot on the Taskbar > Properties > Notification Area > ensure that
Hide inactive icons is not checked.

¢ Taskbar and Start Menu Properties

| Taskbar | Start Menu | Notification Area | Tolbars |

ol & 1255 AM

Icons

You can keep the notification area unduttered by hiding icons that
you have not didked recently.

[] Hide inactive icons

A
i
m

System icons

Select which system icons to always show,

[¥] Clock

[#] Yalume

[¥] Metwork I}

[¥] Power

[ Ok J [ Cancel ] [ Apply ]




2 Operating Your Notebook (Vista)

2.2.6 Recycle Bin i
Recycle Bin

When you delete a file, it is moved to the Recycle Bin. Files can be restored from the
Recycle Bin.
Emptying the Recycle Bin deletes files permanently.

2.2.7 Control Panel

In the Control Panel, you can change how Windows looks and works.
Click the Start button and then Control Panel.

There are two interfaces - you can choose either Control Panel Home or Classic View. You
can switch interfaces in the upper left hand of the Control Panel window.

Choose the task description you wish to complete, and then choose the task in the next
window.

= lie =]
v| + Control Panel » '|‘f| || P|

File Edit View Tools Help

s Control Panel Home =

. System and Maintenance User Accounts and Family
Ui Get started with Windows ¥ Safety
Back up your computer @ Set up parental controls for any user
@Add OF EMOVE USer accounts
Security
Check for updates

Appearance and
Personalization

Change desktop background
Change the celor scheme
Adjust screen reseluticn

Check this computer's security status

@Allow a pregram through Windows
Firewall

;

. Network and Internet
| Connect to the Internet
View network status and tasks

m

Clock, Language, and

Set up file sharing Region
Change keyboards or other input
Hardware and Sound methods
Play CDs or other media automatically
Printer Ease of Access
Mouse Let Windows suggest settings
Optimize visual display
Programs . .
Uninstall a program = Additional Options
—
Restodt Tasks Change startup pregrams
View network status and tasks _ Mobile PC L
Uninstall a program ) Change battery settings
Adjust commeonly used mobility -
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2 Operating Your Notebook (Vista)

2.2.8 Computer

Computer allows you to see the disk drives and other external devices connected to your

notebook. The Computer icon displays on your Desktop. To see the contents of a drive or
folder, open Computer then double-click the icon of the drive or folder you want to view

(for example, drive C).

'Q] You can also use Windows Explorer to see the contents of your notebook and find
files. To open Windows Explorer, right-click the Start button and click Explore.
Find the drive or folder that you want to view. To find out more about Computer
and Windows Explorer, see the Windows Help and Support.
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2 Operating Your Notebook (Vista)

2.3 Keyboard and Touch Pad

> Numeric Keypad

Keyboard Shortcuts

Windows Logo Key Functions
Sticky Keys

Touch Pad

YV VvV V VY V

Customizing the Touch Pad
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2 Operating Your Notebook (Vista)

2.3.1 Numeric Keypad

Keypad numbers and symbols are marked in blue on the lower right edge of the keypad
keys.

. (=]
To enable the numeric keypad, presse—.

The ﬁ indicator will light when the numeric lock is on.

. . EQ
To disable the numeric keypad, press &— again.

To use the primary function of a dual-function key when the numeric keypad is enabled,

Press @ and the desired key.

2.3.2 Keyboard Shortcuts

Sleep

Wireless/Bluetooth Turn On/Off

-
H
e [
2
?.
o e

To enable this function, you need to install Wireless Switch.

= ~ Switches Display Mode (LCD > CRT > TV > LCD + CRT
Simultaneous > LCD+TV Simultaneous). Switches the video image
to the next display or both displays simultaneously.

(7

]
3
—T
a3
L
=
o
C—J

Brightness Down

Brightness Up

]
3
i
2
C—J Cr—J

]
3
@
C—J

Mute

Audio Volume Down

Fn i
=

En | Audio Volume Up
= °

Play/Pause

]
3
3
I
Cr—J
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2 Operating Your Notebook (Vista)

e | | sto
G m‘l P
o |[[™a)] || Fast Rewind

n
E
‘-5

Fast Forward

==
i Number Lock
@ Lmj Scroll Lock
e Caps Lock

2.3.3 Windows Logo Key Functions

= SAE T
@ Opens Windows Explorer
C——OC——
= SAR T .
@ Opens the Run dialog box
C——OC——
= SAF T -
@ Opens the Search Results dialog box
O—VC—

I @*‘ﬁ ctrl DDF H Opens the Search Results - Computers dialog box (when

A=Y your notebook is connected to a network)

B 7| [| Pause
@ ]ml Opens the System Properties dialog box

O

To adjust keyboard operation, including character repeat rate, in the Control Panel click
Hardware and Sound > Keyboard.
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2.3.4 Sticky Keys

The Sticky Keys function lets you use the SHIFT, CTRL, ALT, FN keys or the Windows
logo key (referred to as modifier keys) in conjunction with other keys by pressing one key at
a time instead of simultaneously.

To activate Sticky Keys mode, press the Shift key five times and then click YES.

(&) Sticky Keys =] & s

Do you want to turn on Sticky Keys?

Sticky Keys lets you use the SHIFT, CTRL, ALT, or Windows Logo keys by pressing
one key at a time, The keyboard shortcut to turn on Sticky Keys is to press the
SHIFT key 5 times,

3o to the Ease of Access Center to disable the keyboard shortcut

Yes | I Mo I

Alternatively, you can click on Start > Control Panel > Ease of Access > Change how
your keyboard works and check Turn on Sticky Keys before clicking Save.

(= iE s

@v;h{gﬂ « Ease of Access Center » Make the keyboard easier to use - | +4 | | Search o |
B8 edit View Tools Help

Make the keyboard easier to use
When you select these settings, they will autematically start each time you leg on,

Control the mouse with the keyboard
[] Turn on Mouse Keys

Use the numeric keypad to move the mouse around the screen,

Set up Mouse Keys

m

Make it easier to type
[] Turn on Sticky Keys
Press keyboard shortcuts (such as CTRL+ALT+DEL) one key at a time.

Set up Sticky Keys
[] Turn on Toggle Keys

Hear a tone when you press CAPS LOCK, NUM LOCK, or SCROLL LOCK.
[¥] Turn on Toggle Keys by holding down the NUM LOCK key for 5 seconds

[] Turn on Filter Keys

Ignore or slow down brief or repeated keystrokes and adjust keyboard repeat rates,

Set up Filter Keys

Save Cancel Apply
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To further customize Sticky Keys, click Set up Sticky Keys in the above dialogue box. The
following dialogue box will appear.

f= i S

@‘\Jvkﬁ € Ease of Access » Ease of Access Center » Set up Sticky Keys - | 4 | | Search 2|

File Edit View Teols Help

Set up Sticky Keys
Turn on Sticky Keys
Press keyboard shortcuts (such as CTRL+ALT+DEL) one key at a time.

Keybeoard shertcut
V| Turn on Sticky Keys when SHIFT is pressed five times
When using keyboard shortcuts to turn Ease of Access settings on:
/| Display a warning message when turning a setting on

V| Make a sound when turning a setting on or off

Options

V| Lock modifier keys when pressed twice in a row

| Turn off Sticky Keys when two keys are pressed at once

MNotifications

| Play a sound when keys are pressed

| Display the Sticky Keys icon on the task bar

Cancel Apply

Click Turn on Sticky Keys to enable the listed shortcuts to activate Sticky Keys mode.

By checking Lock modifier keys when pressed twice in a row, pressing the SHIFT,
CTRL, ALT, FN or the Windows logo key twice will “lock’ the key until it is pressed again.
This allows you to perform multiple commands with these keys in succession without
having to press the modifier key again each time.

Check Turn off Sticky Keys when two keys are pressed at once to have Sticky Keys
automatically disable whenever any two keys are pressed simultaneously.

If Play a sound when keys are pressed is checked, a tone will be heard each time a
modifier key is pressed. Different tones are heard when activating and deactivating modifier
keys.

Check Display the Sticky Keys icon on the task bar to display the Sticky Keys icon in
your toolbar whenever the Sticky Keys mode is activated. The icon will change to indicate
which modifier key, if any, is currently active.

Click on Save to confirm your changes, Cancel to exit the dialogue box without making any
changes, or Apply to have your settings take effect without saving.
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2.3.5 Touch Pad

The Touch Pad responds to the movements and pressure of your finger, allowing you to
move the cursor around the screen, in the same way you would with a mouse.

/rJ I

\ ?/

Place your fingers on the keyboard in the normal typing position.

You can use the Touch Pad by moving either your right or left thumb off the space bar and
on to the Touch Pad.

Gently move your thumb across the Touch Pad in the direction you want the cursor to move.

The Touch Pad buttons have the same function as mouse buttons. Clicking these buttons to
make selections, drags objects, or performs a variety of other functions depending on the
software. To select an object, first move the pointer over the object you want to select, and
then press the left button one time and release it. The functionality of these buttons depends
on your software.

Double-clicking is a common technique for selecting objects or launching programs.

You may also select object or execute applications from the icons by double tapping. This is
similar to double-clicking; instead of pressing the Touch Pad buttons, you tap the Touch Pad
itself.

2.3.6 Customizing the Touch Pad

To adjust Touch Pad settings, use the Mouse Properties window, which you can open by
clicking Control Panel > Hardware and sound > Mouse.

Select the desired settings and click Apply.
Click OK to save the settings and close the window.
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2.4 Personalizing Your Desktop

>
>
>
>

Choosing a Wallpaper
Choosing a Screen Saver
Choosing a Desktop Theme

Creating a Shortcut on the Desktop
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2.4.1 Choosing a Wallpaper

To make your notebook reflect your style, you can set background colors, patterns, and the
wallpaper on the desktop.

Control Panel > Appearance and Personalization > Change desktop background.
Choose the picture or color you want for your desktop background.

You can also choose your own images by choosing Browse, and specifying images in a
directory.

Under How should the picture be positioned, choose a way for the position of your
selected image: Fit to screen (scales the image to fit the screen), Tile, or Center (places one
copy of the image in the center of the screen).

To accept the settings, click OK to save your settings and close this window.
2.4.2 Choosing a Screen Saver

Control Panel > Appearance and Personalization > Change screen saver.

Select a screen saver from the Screen saver pull-down menu, or click (None) if you prefer
not to activate a screen saver.

You can customize your screen saver by choosing Settings. To check your selections,
choose Preview.

To accept the settings, click OK and close the Screen Saver Settings window.
2.4.3 Choosing a Desktop Theme

Desktop themes change the appearance of your desktop and add sound effects:
Control Panel > Appearance and Personalization > Change the theme.

Select a theme from the Theme pull-down menu in the Theme Settings Window, and then
click OK.

2.4.4 Creating a Shortcut on the Desktop

A shortcut is an icon that is placed on the desktop let you quickly access programs, files,
folders, and drivers. To create a shortcut:

Open Computer or Windows Explorer, and highlight the file or program you want to
create a shortcut to.

Click and hold down the right Touch Pad button, drag the highlighted item to the Windows
desktop, and then release the right Touch Pad button to display a pop-up menu.

Click Create Shortcuts Here.
An icon appears on your desktop - double-click to activate the shortcut.
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2.5 Display
> Adjusting the Brightness
> Using an External Monitor or Television

> Setting the Display Resolution
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2.5.1 Adjusting the Brightness

To conserve power when running your notebook from the battery, set the brightness to the
lowest comfortable setting using the keyboard shortcuts.

=

Fn

o e

Cr—J

Brightness Down

7

=

Fn

o e

Cr—J

Brightness Up

7

2.5.2 Using an External Monitor

When you start your notebook with an external display device such as an external monitor
attached and turned on, the image may appear on either the display or the external device.

Alternatively, you can press @ to switch the video image to the display only, the
display and the external device simultaneously, or the external device only.

2.5.3 Setting the Display Resolution

To view a program at a specific resolution, both the video controller and display must
support the program and the necessary video drivers must be installed.

Before changing any of the original display settings, note the original settings for future
reference.

Click Start > Control Panel > Appearance and Personalization > Adjust screen
resolution.

You can try different settings for screen resolution and color quality.

If you choose a resolution or color depth that is higher than the display supports, the settings
will automatically adjust to the closest possible setting.
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2.6 Networks

To access a network:
At the office, you can access a network via the built-in PCI-E LAN.

For specific information about connecting to the LAN or WAN, consult your systems
administrator.

If you are working at home or while traveling, you need a dial-up connection. Ask your
system administrator for the telephone number of the network.

To set up the connection, go to Start > Control Panel > Network and Internet > Network
and Sharing Center. Click Set up a connection or network on the left pane of the
Network and Sharing Center window.

Choose a connection option and follow the on-screen instructions to set up your network
connection.
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2.7 Managing Programs
> Running Programs
> Adding Software

> Removing Software
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2.7.1 Running Programs

Programs are any software that process data - like a word processing program or an email
program. They require an operating system - like Windows Vista - to run on.

To run a program, click Start > All Programs.

Click the program you want to run.

On the right side of the title bar in the window of any open program there are three icons:
f=lE s

['=1 Minimize the program window. That is, it is removed from the screen, but is still
running. It will appear as a button on your bottom taskbar. To restore the program window,
simply click the button.

=] Maximize the window to fill your entire screen. When the window is maximized, the
button switches to ', which will reduce the size of the window when clicked.

Close the program or document.
2.7.2 Adding Software

To check what software is already installed on your notebook, click Start > All Programs.
If a program is listed in the All Programs menu or the Start menu, the software is already
installed.

Before installing software, check the software’s technical requirements to ensure that it is
compatible with your notebook and that there is enough memory and hard drive space for
installation and operation.

Temporarily disable your notebook’s antivirus software before installing software. See the
documentation that came with the antivirus software for detailed procedure.

@1 Be sure to enable your antivirus software once you have installed any new software.

Insert the software installation CD into the CD drive and follow the instructions that came
with the software to help you respond to the prompts on the screen.

If the software installation CD does not automatically run, click Start > All Programs >
Accessories > Run. In the dialogue box, type x:\setup.exe (where X is the letter of your CD
drive [usually D or E]). Then click OK and follow the prompts on your screen.
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2.7.3 Removing Software

’@1 Once you’ve begun removing software, do not interrupt the process. To do so may
result in data loss and corruption of your operating system.

Start > Control Panel > Programs > Uninstall a program.

Select the program that you want to remove and click the Uninstall or Change button.
Instructions for removing programs will appear on the screen.

’@1 Some programs may not be listed and cannot be removed via this window. In this
case, check the documentation that came with the specific program.
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2.8 Managing Files

YV Vv VvV YV VYV V VYV VY

Updating Antivirus Software
Backing Up Files

Finding Files

Copying a File on the Hard Drive
Renaming Files

Deleting Files

Emptying the Recycle Bin

Retrieving Files From the Recycle Bin
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2.8.1 Updating Antivirus Software

There are thousands of known viruses, and more appear all the time. Installing antivirus
software is the only way to protect your data, software and hardware. Regular updates are
necessary to ensure protection.

Your notebook dealer can advise you regarding purchasing antivirus software.

Before installing any software from unlicensed sources, scan for viruses. Regularly
backup your data to safeguard against loss if your notebook is infected.

2.8.2 Backing Up Files

Regularly backing up your files will protect you from losing data from accidental file
deletion, viruses or hard drive failure.

Programs can be reinstalled, unless you have backed up your work, you will lose your data
files.

The most convenient way to back up your files is to a CD-RW drive. For smaller files, you
can use a floppy disk.

2.8.3 Finding Files

Right click on Start > Search.
In the search window, type a word or part of a word in the search box.

As you type, files from a variety location (drives and folders on your notebook) that match
your text will appear.

You can click one of the available filter buttons to show only certain kinds of files, such as
E-mail, Document, Picture, or Music.

2.8.4 Copying a File on the Hard Drive

From the Desktop, select Computer.

Locate the file you want to copy, and click the file to select it.
Right click the file you want to copy, and then click Copy.
Open the location where you want to store the copy.

Right click within the location, and click Paste.
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2.8.5 Renaming Files

Use Windows Explorer or Computer to locate the file you want to rename, and click the
file to select it.

Click the Organize menu and select Rename.

Never change a file’s extension (the last three characters after the period). Doing so
may render the file unusable.

Type the new filename and press Enter.

2.8.6 Deleting Files

Never delete files that are part of an installed program. Doing so may render the file
unusable.

Use Windows Explorer or Computer to locate the file you want to delete, and click the file
to select it.

Click the Organize menu and click Delete.
Click Yes to send the file to the Recycle Bin.
If you accidentally delete a file, see 0 2.8.8 Retrieving Files From the Recycle Bin.

2.8.7 Emptying the Recycle Bin

Files remain in the Recycle Bin and take up space on the hard drive until you empty them
from the Recycle Bin.

Files deleted from an external drive or from a network are permanently erased. You
cannot recover them from the Recycle Bin.

Double-click the Recycle Bin icon.

The Recycle Bin window appears and lists all deleted files, their previous locations, and the
dates you deleted them.

Click the File menu, and click Empty Recycle Bin.
When the confirmation dialog box appears, click Yes to delete all file(s).
All files disappear from the Recycle Bin and are removed from your notebook.
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2.8.8 Retrieving Files From the Recycle Bin

Deleted files are moved to the Recycle Bin and remain there until you empty the Recycle
Bin. If you delete a file in error, you can retrieve it from the Recycle Bin:

2l
E ]
-

Double-click the Recycle Bin Recycle Bin jeon,

The Recycle Bin window will appear, listing all deleted files, their previous locations, and
the dates you deleted them.

Select the file you want to retrieve, and click Restore this item.
The file disappears from the Recycle Bin and is moved to its original location.
You can also recover all the files from the Recycle Bin by clicking Restore all items.
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2.9 Playing CDs and Movies
> Inserting Discs
> Adjusting the Volume

> Adjusting the Picture
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2.9.1 Inserting Discs

Be careful not to press down on the drive tray when opening or closing it. When the
drive is not in use, keep the tray closed.

& Do not move the computer when playing CDs or DVDs.

To insert a disc, do the following:

1. Press the eject button on the front of the drive.

2. Pull the tray out.

3. With the label side up, place the disc in the center of the tray.

4. Snap the disc onto the spindle.

5. Gently push the tray back into the drive.

If your notebook has a CD-RW/DVD or DVD, you can watch movies.

For more information on playing CDs or watching movies, click Help on the CD player
software or DVD player software.

2.9.2 Adjusting the Volume

r@‘ If you do not hear anything when playing a CD or DVD, check that the speakers are
not muted.

Start > All Programs > Accessories > Windows Mobility Center.

In the Windows Mobility Center window, click and drag the bar in the Volume column
and slide it left or right to decrease or increase the volume.

= Iml Audio Volume Down
o
Cm—

o P« | Audio Volume Up
ey —

2.9.3 Adjusting the Picture

If you receive an error message that the current resolution and color depth are using too
much memory and preventing DVD playback, adjust the display properties:

Start > Control Panel > Appearance and personalization >
Personalization> Display Settings.

In the Display Properties window, click and drag the bar in Resolution section to change
the setting to 1024 x 768 pixels.

Click the pull-down menu under Colors, select Medium (16 bit), and click OK.
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3.1 rning Your Notebook On and Off

3-1
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Turning Your Notebook On
Turning Your Notebook Off
Logging Off

Adding User Accounts
Standby Mode
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3.1.1 Turning Your Notebook On

You can configure the computer to start from a specific drive, such as a CD-ROM,
an external floppy disk, or even an external device. See ,%‘,%4 bodls ,:'7/‘2,%/%5% Tkt o SF

D IS IR

4

Press the power button D to turn on your notebook.

.. Do not turn off the computer until the operating system has loaded completely.
- Turning the computer off during its initial startup will result in an error the next
time you start your notebook.

3.1.2 Turning Your Notebook Off

If your notebook uses Microsoft Windows XP Professional operating system, the
security and networking features are not available in Windows XP Home Edition.
You will see different options in some windows, related to security and networking.

4

Save and close any open files, exit any open programs.
Click Start > Turn Off Computer > Turn Off.
Your notebook will automatically turn off after the shutdown process is finished.

y~ You can configure Windows XP to shut down or go into sleep mode by pressing the
- power button. Open the Control Panel > Power Options > Advanced dialog box to
do this.

3.1.3 Logging Off

With Microsoft Windows XP, multiple users can access a single computer with their own,
personal settings. Using their own password, each user logs on to the computer, meaning
other users cannot access their settings or files. To log off:

Save and close any open files, exit any open programs, click Start > Log Off > Log Off.
To switch users, click Start > Log Off > Switch User.

Using Fast User Switching, programs executed by previous users remain running in the
background. This means a possible slower computer response. It may also stop multimedia
programs, including games and DVD software, from running.

Fast User Switching does not work if your notebook is running Windows XP
Professional and is a member of a computer domain or if the notebook has less than
128 MB of memory.

4

You can set up Fast User Switching in the Control Panel dialog box, under User
Accounts: Change the way users log on or off.
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3.1.4 Adding User Accounts

}jf' Different account options are available when a computer is running Windows XP
Professional operating system and is connected to a domain.

With Windows XP installed, the system administrator or a user with administrator rights can
create additional user accounts:

1. Click Start > Control Panel > User Accounts.

2. Under Pick a task, click Create a new account.

3. Under Name the new account, enter the name of the new user. Click Next.
4. Under Pick an account type, choose one of the following options:

e Computer administrator: User can change all computer settings.

e Standard (Windows XP Professional only): User can install some programs
and hardware.

e Limited: User can only change his own personal settings, such as the password.
User is not able to install programs or use the Internet.

5. Click Create Account.

3.1.5 Standby Mode

To find out how to conserve power using the Standby Mode, see 0 8.1 Power Management.
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3.2 Tips for Using Windows

YV Vv Vv YV VY V¥V VYV VY V

Microsoft Windows XP Help
Windows Desktop

Desktop Cleanup Wizard

Start Button

Taskbar

Notification Area (System Tray)
Recycle Bin

Control Panel

My Computer
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3.2.1 Microsoft Windows XP Help

For Microsoft Windows XP help, click the Start menu then click the Help and Support
icon. The Help and Support Center dialog box opens.

() Help and Support Conter

& Help and Support Center

Ask for assistance

i ot T e r-!;! 3 & hvered Tn orrect B yoar coespulss veith Hemmote Assabance

& Lher pnd syt e quedes IE. ot samapnrt, or fevdirformation i Windows %1 nessgroups

Walual " rorrm an Windoees X0 Fh:h- a‘ta_ﬁl‘{
& Mk, vides, ganses, and phol o

v Winakiws hasicu [F] e your compute 1peto-duce weth Windows iigdate

[ Fred compatible hardware and solbeare (o Windres
S Euvipw i aned Lher Vil

Wiesrlineg remnobely r-i| Lk i bsargme o e compude with Syslesn Hestore
Securdy ansd ackeninmdration

!+' LHa Ttk 1 wwed yoior Cafr{n End i i od o Raghinn prolieih

C i dwii i Zna yiisr Clafiupisl ev

5 . _ "
A s sbalil y Dld ?uu Hﬂﬂw,

Pkl e dmvil Heiiginng
Performangn sl maintenance
Haiilwiire

Tisiruy @ prohlem

Seimd yoia [ewifhack be Microsall
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3.2.2 Windows Desktop

Depending on your notebook setup and software, your desktop may have different or
additional shortcuts. See 0 3.4 Personalizing Your Desktop for more information.

Recycle
Bin

i
fy

Windows

Professional

Start button Taskbar Notification Area
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3.2.3 Desktop Cleanup Wizard

The Desktop Cleanup Wizard moves icons for programs not frequently used to a folder 7
days after you first start your notebook and every 60 days after that.

The Start menu's appearance changes as program icons are moved. To turn off the Desktop
Cleanup Wizard:

Right-click an empty spot on your desktop > Properties > Desktop > Customize Desktop
> click Run Desktop Cleanup Wizard every 60 days to remove the check mark > OK.

The Desktop Cleanup Wizard can be run any time by clicking Clean Desktop Now under
Desktop cleanup.

3.2.4 Start Button

The Start button allows easy access to your notebook's programs.

[ y Internet .-) My Documents
Internet Explorer Ve
; 1 My Recent Documents »
-r"] E-mail L-E} s =
= Outlook E 3
HERREERES .EJ My Pictures
g ] :
Matepad ___f My Music
o My Computer
ﬁ Thermal 5!
L4
=3 ) G) Control Panel
Files and Settings Transfer
" Wizard Set Program Access and
@ Defaulks
g} sndrec3z
C (S ]
2 e_:‘ onneck To
LJE; HypsrSnap-D 5 !Qﬂ Printers and Faxes
o
& CoCTE @ Help and Support
I‘) Search
| All Programs D =7 Run...

The Start menu is designed to show the programs you use most frequently. To always keep
an item on the Start menu, no matter how often it's used, right-click the item and click Pin
to Start menu.

Log Off allows the current user to log off so a new user can log on to the notebook using his
personal settings.

Turn Off Computer provides options for turning off, restarting, and placing your notebook
in power saving modes. If your notebook is running Windows XP Professional and is
connected to a domain, different options appear in the Shut Down window.
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3.2.5 Taskbar

The Start button is on the left and the notification area on the right. Each time you open a
program, a button for it appears on the taskbar. To toggle taskbar buttons, click the relevant
button. Windows XP groups multiple instances of the same program on a single taskbar
button if more space is needed.

Toolbars can be added to or removed from the taskbar:
Right-click an empty spot on the taskbar, and select Toolbars > choose the toolbar you
want to add.

3.2.6 Notification Area (System Tray)

The icons in this area allow quick access to programs and computer functions, including the

clock and printer status. Windows XP hides icons that are not used frequently. Click ¥ to
see hidden icons.

To prevent Windows XP from hiding icons:

Right-click an empty spot on the Taskbar > Properties > ensure that Hide inactive icons is
not checked.

Taskbar and Start Menu Properties

Taskbar | Start Menu

Tazkbar appearance

R -
:a Start 2 owielcorne... | 7. Mina's Webs..

[ Lock the taskbar

[ Auto-hide the taskbar

F.eep the tazkbar on top of other windows
[ Group similar taskbar buttons

[] 5how Quick Launch

Motification area

1 T |2 1223 M

Show the clock

You can keep the natification area uncluttered by hiding icons that you
have not clicked recently.

[[]Hide inactive icons

ak ] [ Cancel

-
2
3.2.7 Recycle Bin
Recycle Bin

When you delete a file, it is moved to the Recycle Bin. Files can be restored from the
Recycle Bin.

Emptying the Recycle Bin deletes files permanently.
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3.2.8 Control Panel

In the Control Panel, you can change how Windows looks and works.
Click the Start button and then Control Panel.

There are two interfaces - you can choose either Classic View or Category View. You can
switch interfaces in the upper left hand of the Control Panel window.

Under Pick a category, choose the category of the task you wish to complete, and then
choose the task in the next window.

£ Control Panel

File Edit Wiew Favorites Tools  Help

Q Back \J LE p Search IC Folders Ev

address U* Control Panel

E"' Control Panel £ PiCk a category

3 Switch to Classic Yisw

See Also

L -
|\ 2™ Appearance and Themes Printers and Other Hardware

& wWindows Update P .
@) Help and Support "  Network and Internet Connections &, User Accounts

Other Contral Panel -

Options ;
E Bl oy REmove Praarams Dat!a. Time, Language, and Regional
Options

\f e . ‘bl ;
- J Sounds, Speech, and Audio Devices (= Accessibility Options

T—‘ Performance and Maintenance 4 Security Center

a My Computer

3.2.9 My Computer

My Computer allows you to see the disk drives and other external devices connected to
your notebook. The My Computer icon appears on your Desktop. To see the contents of a
drive or folder, open My Computer then double-click the icon for the drive or folder you

want to view (for example, drive C).

p You can also use Windows Explorer to see the contents of your notebook and find
files. To open Windows Explorer, right-click the Start button and click Explore to
find the drive or folder that you want to view. To find out more about My Computer
and Windows Explorer, see Help and Support Center.
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3.3 Keyboard and Touch Pad

Numeric Keypad

Keyboard Shortcuts

Windows Logo Key Functions
StickyKeys

Touch Pad

YV V V YV VY V¥V

Customizing the Touch Pad
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3.3.1 Numeric Keypad

Keypad numbers and symbols are marked in blue on the lower right edge of the keypad
keys.

. (=]
To enable the numeric keypad, press t—=.

The ﬁ indicator will light when the numeric lock is on.

[ um k1
To disable the numeric keypad, press l.l again.
To use the primary function of a dual-function key when the numeric keypad is enabled,

press @ and the desired key.

3.3.2 Keyboard Shortcuts

]
3
1
@~
C—J

Sleep

A 2 Wireless/Bluetooth On/Off

-
H
‘-E

To enable this function, you need to install Wireless Select Switch.

Switches Display Mode (LCD >LCD+ CRT > CRT). Switches the
video image to the next display or both displays simultaneously.

]
3
a3
L
=
o
C—J

Brightness Down

Brightness Up

H\
£
. ! !

-
H
A
B
o

Mute

Audio Volume Down

Audio Volume Up

]
3
-
A
-
C—J

n
E
@
C—J

Play/Pause

3
I
C—J C—J

Stop
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I

—
‘E—v

Fast Rewind

p

I

Fast Forward

LI

p

—
‘E—v

v

Number Lock

€
o

@ Scroll Lock
(o Caps Lock

3.3.3 Windows Logo Key Functions

— .' T E - -

ay Opens Windows Explorer
O
— .' T R - -

ay Opens the Run dialog box
O
— .' T F - -

ay Opens the Search Results dialog box
C——C——=
I Ay e I# F Opens the Search Results - Computers dialog box (when
A NA—NA—= your notebook is connected to a network)
N ay S Pause

Ay | A5k Opens the System Properties dialog box
=

To adjust keyboard operation, including character repeat rate, in the Control Panel click
Printers and Other Hardware > Keyboard.
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3.3.4 StickyKeys

The StickyKeys function lets you use the SHIFT, CTRL, ALT, FN keys or the Windows
logo key (referred to as modifier keys) in conjunction with other keys by pressing one key at

a time instead of simultaneously.

To activate StickyKeys mode, press the Shift key five times and then click OK.

Alternatively, you can click on Start > Control Panel > Accessibility Options and check

StickyKeys

Preszing the SHIFT key 5 times turns on Shckykeps. Stickykevs lets vou use
the SHIFT, CTRL, ALT. or Windows Logo keyps by prezsing one key at a time,

To keep Stickyk.evs an, click OF.
Tao cancel Stickykeps, click Cancel.
To deactivate the key combination for Stickyk.eys, click Settings.

................................

(] Cancel Settings

................................

Use StickyKeys before clicking OK.
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Accessibility Options

Feyboard | Sound | Display | Mouse | Gereral

Stickyk.eps

ze Stickytens if pou want to uze SHIFT, CTRL, ALT, ar
Windows logo key by pressing one key at a time.

Uze Stickyk.eys Settings

Filterk.eyps

[Jze Filterk.eys if vou want Windows o ignore brief or repeated
keystrokes, or glow the repeat rate.

[ ] Use Filterk eys Settings

Togglekeys

Jze Togglekeys if pou want to hear tones when pressing
CAPS LOCK, MUK LOCE, and SCROLL LOCE.

[]Usze Togglekeys Settings

[ ] 5Show extra keyboard help in programs

k. H Cancel ” Apply
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To further customize StickyKeys, click Settings in either of the above dialogue boxes. The
following dialogue box will appear.

Settings for StickyKeys E]El

F.eyboard shartcut

The ghartcut far Stickyleys i
Prezz the SHIFT key five times.

Uze shortcut

Ophionz
Prezz modifier key twice to lock
Turn Stickyk.evs off if two keys are pressed at once

M otification
b ake sounds when modifier key iz pressed
Show Stickyk.eys statuz on screen

l OF. ] ’ Cancel

Click Use shortcut to enable the listed shortcut to activate StickyKeys mode.

By checking Press modifier key twice to lock, pressing the SHIFT, CTRL, ALT, FN or
the Windows logo key twice will 'lock’ the key until it is pressed again. This allows you to
perform multiple commands with these keys in succession without having to press the
modifier key again each time.

Check Turn StickyKeys off if two keys are pressed at once to have StickyKeys
automatically disable whenever any two keys are pressed simultaneously.

If Make sounds when modifier key is pressed is checked, a tone will be heard each time a
modifier key is pressed. Different tones are heard when activating and deactivating modifier
keys.

Check Show StickyKeys status on screen to display the StickyKeys icon in your toolbar
whenever the StickyKeys mode is activated. The icon will change to indicate which
modifier key, if any, is currently active.

Click on OK to confirm your changes, or Cancel to exit the dialogue box without making
any changes.
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3.3.5 Touch Pad

The Touch Pad responds to the movements and pressure of your finger, allowing you to
move the cursor around the screen, in the same way you would with a mouse.

Place your fingers on the keyboard in the normal typing position.

You can use the Touch Pad by moving either your right or left thumb off the space bar and
on to the Touch Pad.

Gently move your thumb across the Touch Pad in the direction you want the cursor to move.

The Touch Pad buttons have the same function as mouse buttons. Clicking these buttons
makes selections, drags objects, or performs a variety of other functions depending on the
software. To select an object, first move the pointer over the object you want to select, and
then press the left button one time and release it. The functionality of these buttons depends
on your software.

Double-clicking is a common technique for selecting objects or launching programs.

You may also select object or execute applications from icons by double tapping. This is
similar to double-clicking; instead of pressing the Touch Pad buttons, you tap the Touch Pad
itself.

3.3.6 Customizing the Touch Pad

To adjust Touch Pad settings, use the Mouse Properties window, which you can open by
clicking Control Panel > Printers and Other Hardware > Mouse.

Select the desired settings and click Apply.
Click OK to save the settings and close the window.
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3.4 Personalizing Your Desktop

> Choosing a Wallpaper

> Choosing a Screen Saver

> Choosing a Desktop Theme
>

Creating a Shortcut on the Desktop
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3.4.1 Choosing a Wallpaper

To make your notebook reflect your style, you can set background colors, patterns, and the
wallpaper on the desktop.

Control Panel > Appearance and Themes > Pick a task > Change the desktop
background.

The Display Properties window offers a choice of wallpapers. Choose the name of the
wallpaper you want to display, or choose (None) if you prefer not to use a wallpaper image.

You can also choose your own images by choosing Browse, and specifying images in a
directory.

The Position pull-down menu lets you either Tile your selected image, Center (places one
copy of the image in the center of the screen) or Stretch (enlarges it to fit the screen).

To accept the settings, click OK and close the Display Properties window.
3.4.2 Choosing a Screen Saver

Control Panel > Appearance and Themes > Pick a task > Choose a screen saver.

Select a screen saver from the Screen saver pull-down menu, or choose (None) if you prefer
not to activate a screen saver.

You can customize your screen saver by choosing Settings. To check your selections, click
Preview.

To accept the settings, click OK and close the Display Properties window.
3.4.3 Choosing a Desktop Theme

Desktop themes change the appearance of your desktop and add sound effects:

Control Panel > Appearance and Themes > Pick a task > Change the computer's
theme.

Select a theme from the Theme pull-down menu in the Display Properties Window, and
then click OK.

3.4.4 Creating a Shortcut on the Desktop

A shortcut is an icon that is placed on the desktop let you quickly access programs, files,
folders, and drivers. To create a shortcut:

Open My Computer or Windows Explorer, and highlight the file or program for which
you want to create the shortcut.

Click and hold down the right Touch Pad button, drag the highlighted item to the Windows
desktop, and then release the right Touch Pad button to display a pop-up menu.

Click Create Shortcuts Here.
An icon appears on your desktop - double-click to activate the shortcut.
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3.5 Display

> Adjusting the Brightness
> Using an External Monitor or Television

> Setting the Display Resolution
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3.5.1 Adjusting the Brightness

To conserve power when running your notebook from the battery, set the brightness to the
lowest comfortable setting using the keyboard shortcuts.

ry

Fn

o e

Cr—J

Brightness Down

7

ry

Fn

o e

C—)

Brightness Up

7

3.5.2 Using an External Monitor

When you start your notebook with an external display device such as an external monitor
or attached and turned on, the image may appear on either the display or the external device.

Alternatively, you can press @ to switch the video image to the display only, the
display and the external device simultaneously, or the external device only.

3.5.3 Setting the Display Resolution

To view a program at a specific resolution, both the video controller and the display must
support the program and the necessary video drivers must be installed.

Before changing any of the original display settings, note the original settings for future
reference.

Click Start > Control Panel > Pick a category > Appearance and Themes.

Under Pick a task..., click Change the screen resolution, or under or pick a Control
Panel icon, click Display and select Settings tab.

You can try different settings for Screen resolution and Color quality.

If you choose a resolution or color palette that is higher than the display supports, the
settings will automatically adjust to the closest possible setting.
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3.6 Networks

To access a network:
At the office, you can access a network via the built-in PCI-E LAN.

For specific information about connecting to the LAN or WAN, consult your systems
administrator.

If you are working at home or while traveling, you need a dial-up connection. Ask your
system administrator for the telephone number of the network.

To set up the connection, go to Start > Control Panel > Network and Internet
Connections (in Classic Interface, Network Connections).

Enter the details for your connection and click OK.
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3.7 Managing Programs

> Running Programs
> Adding Software

> Removing Software
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3.7.1 Running Programs

Programs are any software that process data - like a word processing program or an email
program. They require an operating system - like Windows XP - to run on.

To run a program, click Start > Programs.
Click the program you want to run.
On the right side of the title bar in the window of any open program,

there are three icons: Elm

E minimizes the program window. That is, it is removed from the screen, but is still
running. It will appear as a tab on your bottom taskbar. To restore the program window,
simply click the tab.

E] maximizes the window to fill your entire screen. When the window is maximized, the
button switches to which will reduce the size of the window when clicked.

ﬂ closes the program or document.
3.7.2 Adding Software

To check what software is already installed on your computer, click Start > All Programs.
If a program is listed in the All Programs menu or the Start menu, the software is already
installed.

Before installing software, check the software's technical requirements to ensure that it is
compatible with your notebook and that there is enough memory and hard drive space for
installation and operation.

Temporarily disable your notebook’s antivirus software before installing software. See the
documentation that came with the antivirus software for detailed procedure.

) Be sure to enable your antivirus software once you have installed any new software.

}/

Insert the software installation CD into the CD drive and follow the instructions that came
with the software to help you respond to the prompts on the screen.

If the software installation CD does not automatically run, click Start > Run. In the
dialogue box, type x:\setup.exe (where X is the letter of your CD drive [usually D or E]).
Then click OK and follow the prompts on your screen.
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3.7.3 Removing Software

}jf' Once you've begun removing software, do not interrupt the process. To do so may
result in data loss and corruption of your operating system.

Start > Control Panel > Add or Remove Programs > Change or Remove Programs.

Select the program that you want to remove and click the Change/Remove button.
Instructions for removing programs will appear on the screen.

) Some programs may not be listed and cannot be removed via this window. In this
é}/
case, check the documentation that came with the specific program.

3-23



3 Operating Your Notebook (XP)

3.8 Managing Files

Updating Antivirus Software
Backing Up Files

Finding Files

Copying a File on the Hard Drive
Moving Files

Renaming Files

Deleting Files

Emptying the Recycle Bin

YV Vv Vv YV VY V¥V VYV VY V

Retrieving Files From the Recycle Bin
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3.8.1 Updating Antivirus Software

There are thousands of known viruses, and more appear all the time. Installing antivirus
software is the only way to protect your data, software, and hardware. Regular updates are
necessary to ensure protection.

Your computer dealer can advise you regarding purchasing antivirus software.

/1 Before installing any software from unlicensed sources, scan for viruses. Regularly
- backup your data to safeguard against loss if your notebook is infected.

3.8.2 Backing Up Files

Regularly backing up your files will protect you from losing data from accidental file
deletion, viruses or hard drive failure.

Programs can be reinstalled, unless you have backed up your work, you will lose your data
files.

The most convenient way to back up your files is to a CD-RW drive. For smaller files, you
can use a floppy disk.

3.8.3 Finding Files

Right click on Start > Search.

In the search window, type either All or part of the file name or A word or phrase in the
file.

Specify where you want the system to look by specifying a drive or folder in the Look in
pull-down menu.

}jf' Windows will search the entire hard drive (or drive C partition) if the default setting
of C: is unchanged.

Click Search to begin searching.
Files found that match your search criteria are listed in the Search Results window.

3.8.4 Copying a File on the Hard Drive

From the Desktop, select My Computer.

Locate the file you want to copy, and click the file to select it.

Under File and Folder Tasks > Copy this file.

In the Copy Items window, select the location where you want to copy the file.
Click Copy.
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3.8.5 Moving Files

. Never move files that are part of an installed program. Doing so may make the
- program unusable.

From the Desktop, select My Computer.

Locate the file you want to move, and click the file to select it.

Click Move this file.

In the Move Items window, click the location where you want to move the file.

Click Move.
3.8.6 Renaming Files

Use Windows Explorer or My Computer to locate the file you want to rename, and click
the file to select it.

Click the File menu and click Rename.
. Never change a file's extension (the last three characters after the period). Doing so
- may render the file unusable.

Type the new filename and press Enter.

3.8.7 Deleting Files

. Never delete files that are part of an installed program. Doing so may render the file
7 unusable.

Use Windows Explorer or My Computer to locate the file you want to delete, and click
the file to select it.

Click the File menu and click Delete.
Click Yes to send the file to the Recycle Bin.
If you accidentally delete a file, see 0 3.8.9 Retrieving Files From the Recycle Bin.
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3.8.8 Emptying the Recycle Bin

Files remain in the Recycle Bin and take up space on the hard drive until you empty them
from the Recycle Bin.

. Files deleted from an external drive or from a network are permanently erased. You
@ cannot recover them from the Recycle Bin.

Double-click the Recycle Bin icon.

The Recycle Bin window appears and lists all deleted files, their previous locations, and the
dates you deleted them.

Click the File menu, and click Empty Recycle Bin.
When the confirmation dialog box appears, click Yes to delete all file(s).
All files disappear from the Recycle Bin and are removed from your notebook.

3.8.9 Retrieving Files From the Recycle Bin

Deleted files are moved to the Recycle Bin and remain there until you empty the Recycle
Bin. If you delete a file in error, you can retrieve it from the Recycle Bin:

f
i |
Double-click the Recycle Bin _!_-;' icon.
Recycle Bin

The Recycle Bin window will appear, listing all deleted files, their previous locations, and
the dates you deleted them.

Select the file you want to retrieve, click the File menu, and then click Restore.
The file disappears from the Recycle Bin and is moved to its original location.
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3.9 Playing CDs and Movies

> Inserting Discs
> Adjusting the Volume

> Adjusting the Picture
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3.9.1 Inserting Discs

/1. Becareful not to press down on the drive tray when opening or closing it. When the
@ driveis notin use, keep the tray closed.

uLl Do not move the computer when playing CDs or DVDs.

To insert a disc, do the following:

6. Press the eject button on the front of the drive.

7. Pull the tray out.

8. With the label side up, place the disc in the center of the tray.

9. Snap the disc onto the spindle.

10. Gently push the tray back into the drive.

If your notebook has a CD-RW/DVD or DVD, you can watch movies.

For more information on playing CDs or watching movies, click Help on the CD player
software or DVD player software.

3.9.2 Adjusting the Volume

}/I' If you do not hear anything when playing a CD or DVD, check that the speakers are
" not muted.

Start > All Programs > Accessories > Entertainment > Volume Control.

In the Volume Control window, click and drag the bar in the Volume Control column and
slide it up or down to increase or decrease the volume.

= Iml Audio Volume Down
T

f (| [|™ @] | Audio Volume Up
ey —

3.9.3 VAdjusting the Picture

If you receive an error message that the current resolution and color depth are using too
much memory and preventing DVD playback, adjust the display properties:

Start > Control Panel > Pick a category > Appearance and Themes > Pick a task... >
Change the screen resolution.

In the Display Properties window, click and drag the bar in Screen resolution to change
the setting to 1024 x 768 pixels.

Click the pull-down menu under Color quality > Medium (16 bit) > OK
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About this Feature Guide

This feature guide is designed to highlight and clearly illustrate the 2008 innovative features
and let you easily understand, hands-on, the most important is, to utilize this innovative
features at the best efficiency.

What you can find in this guide:
* Introduces the 2008 innovative features come with your laptop.

* lllustrates the feature details in operation procedure and applicable scenario.
* Highlight the characteristic of the new innovative features.

Information in this document is subject to change without notice

© Compal Electronics, Inc. 2008. All rights reserved.

Trademarks used in this document: Microsoft and Windows are registered trademarks of
Microsoft Corporation.

Other trademarks and trade names may be used in this document to refer to either the entities
claiming the marks and names or their products.

Features described in this product guide are developed and copyright owned by Compal
Electronics, Inc. Some of the features may not be available in certain models.

The combination of the features is model dependent.

What Features we are offering to you
Program DJ contains a set of innovative value-added software that brings you the consideration
and convenience features.

Video and Audio preference setting for joyful experience.

Advanced biotechnology on facial recognition and identification system for in depth security
control.

Power management on system camera monitoring, battery charging methodology and extra
power source ports.

Camera monitoring usage for protecting content security from been stolen.
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* Easy Logon
o ..

0. @__Program DJ

Easy to launch Compal Innovative Products

Friendly operation to fast select various applications

Enables better control, design, and development from richer user interface
Experience the different impressions on using and controlling applications

 Power Control

(2\ Green Charqer

¢ By adjusting the methodology of the battery capacity recharging, Green Charger can extend
total battery efficiency and life cycle

e Users choose the most appropriate mode according to their using behavior.

» Joyful Experience

—
\

VV OW Audio

e WOW Audio is a setting assortment for audio conditions preset in Tone, Bass, Balance and
\Volume that offer users a chance to select the most-fit combination according to their
preference.

e The preset scenarios are Normal, Speech, Classic, Rock and POP

\h@/\/ WOW Video

e Setting assortment for video conditions preset in Color Defines, Resolutions and Viewing to
select that offer users a chance to select the most-fit scenario according to their preference.

e The preset scenarios are Normal, Office, Photo, Movie and User Define.

e The User Define option provides user an advanced chance to customize their personal
scenario.
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» Depth Security Control

When power-on, the system automatically enable the build-in webcam and execute a
security check from its database to see if the user had been authorized to allow to get into the
system or not.

it is very safe for neither ID nor password be showed on the screen.

@s mart Watchdo

Smart Watchdog can detect the presence of the users for an advanced power management and
enhance the security of the data inside the System from spying.

Safety Guard

o Safety Guard utilizes camera and microphone to guard your properties. If any behavior had
been detected, Safety Guard starts to record and stores the frames in the storage.
¢ Provides the remote notification function by sending out users email and SMS

» User Friendly

S2
ai Wirslsii §wi;gh

¢ Providing a GUI interface for fast wireless switching on existing wireless devices.
e When Bluetooth and WLAN (802.11X) devices both exist, users can switch both or either
device on or off according to their preference.
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M in retar

It provides users an excellent function for recording your own audio or audio/video clips.
Value added and consideration program provides a user friendly operation interface and
extends the system usability.

Innovative Product Feature

How to Launch Innovative product
From Start Menu

Innovative Product can be launched from start menu
Start--> Program DJ--> Innovative Product

From Program DJ

By clicking on the Innovative Product icon can be launch the Program DJ

Scenarios
Launch Compal application via Program DJ
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4.1 Easy Logon

4.1.1 Program DJ

Wireless Switch

ProgramDJ

Figure 01: Program DJ Main Flash

Operation Procedure
To launch Program DJ, the Program DJ mains interface appears for users to select the program
they want to use.

With flash installed, users can see a flash enabled main interface can be seen and operated;
otherwise, only a mini bar Manu will be available to operate.

The sequence of icons depends on what and how much application has been installed.

The application quantities may not be the same because some applications need special
hardware.

The main interface

With mouse over the application, the description of that program feature will be displayed in
the center box. To launch the application, simply by either double clicking on the icon or single
click on the “Launch” button.
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ProgramDJ

Ry e
WOW Video -
Meeting Secretary

Launch

Figure 02: Program DJ Main Interface

The Program DJ Mini bar

After launched either of the applications, the flash enabled main interface will minimize into a
mini bar and wait for next application launch.

When specific of application is used, the application button will be display in highlighted
background.

Figure 03: Program DJ Mini bar

[ = .
Bl Notice Scale button:

Sia
Users can click the scale button to switch Program DJ between main interface and

mini bar.
m Close button:

Users can click the close button to close Program DJ program.
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4.2 Power Control

4.2.1 Green Charger

Scenarios
An environmental care concept had been applied to the product by utilizing the mechanism of
battery management to keep the earth green as well as extend the life cycle of the battery usage.

Main Functions

There are 3 modes to choose from when recharging the battery. Users choose the most
appropriate mode according to their using behavior.

Green Charger

[X) 100% Battery Full Charging

ol

X107 E——r————

I/

0 50% Extended Battery Lifa Cycle

Figure 04: Green Charger Configuration Dialog

9| Battery Full Charged

E?g Green Charger will charge the battery to a fully charged status of its
el capacity. The benefit for this mode is to maintain the battery in its
biggest capacity status against to its nature decadency.

(2) e Balanced

Green Charger will charge the battery to a 75% charged status of its
28 capacity. The benefit for this mode is to meet the advantage between
battery Capacity and Life Cycle.

(3) £ Extended Battery Life Cycle
Green Charger will charge the battery to a 50% charged status of its
G107

capacity. The benefit for this mode is to extend the battery life cycle
from its material characteristics.
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If you need to use the notebook in the DC mode, you should need a full-charged battery to
extend DC mode usage duration.

“On-the-Go” Button

After the user click the ““On-the-Go” button to launch this feature,
the system will charge the battery up to 100% capacity while in the
“75% Balanced” & “50% Extended Battery Life Cycle” modes. After
the battery is charged completely, it will not charge any more and the
charging ratio settings will restore to the current user preference.

4 =

Note that if you still plug the AC cable, the battery will discharge to
current charging ratio. (Ex. 75% or 50%). This is a feature of only one
time for every single press. Then, users can go for a meeting or others
with full-charged battery and without power cord.

& 1. User can click the “Default’ button to load the default Green Charger settings.
After clicking the “Default” button, it will restore all options to default settings. It will
activate the settings only after clicking the “OK”” button, or else, discard them by
clicking other buttons.

2. User can click the “OK”” button to save the current Green Charger settings and make
the changes take effect.

3. User can click the “Close” or ““X” button to discard all the changes. All of the
original settings will not be changed.
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4.3 Joyful Experience

4.3.1 WOW Audio(Vista only)

Scenario

WOW Audio is a setting assortment for Audio conditions preset in Color Defines, Resolutions
and Viewing Sizes that offer users a chance to select the most-fit scenario according to their
preference.

Speech Classic

Figure 05 : WOW Audio Configuration Dialog

Main Function
1. Normal: Presents the sound based on the factory default settings

2. Speech: Provides users the sound in enhancing human-voice frequency portions to present
the sound more clearly.

3. Classic: Provides users the sound in moderate to present the characteristics of the classics
music.

4. Rock: Provides users the sound in moderate to present the characteristics of the Rock music.

5. POP: Provides users the sound in by enhancing mid-range frequency portions to present the
sound without extreme high tone or high bass.

4.3.2 WOW Video(Vista only)

Scenario

WOW Video is a setting assortment for Video conditions preset in Tone, Bass, Balance and
\Volume that offer users a chance to select the most-fit combination according to their
preference. The preset scenarios are Normal, Speech, Classic, Rock and POP
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The preset scenarios are Normal, Office, Photo, Movie and User Define. Define. The User
Define option provides user an advanced chance to customize their personal scenario.

Figure 06: WOW Video Configuration Dialog

Main Functions
1. Normal: Presents the graphics based on the factory default settings
2. Office: Provides users the graphics in detail to present the character/letter more clearly.

edges on letters for better readability

3. Photo: Provides users the graphics in enhanced color to present the picture more saturated.

4. Movie: Provides users the graphics in dimmer to present the movie in a condition more
suitable for longer period watching.

[ 2T - —~

Figure 08 : oto mode (circle left) rovides higher details on objects,
while Movie mode (circle right) provides lower.

5. User Define: Allows users to have their own unique system setting according their
preference.

4-10



Innovative Product Feature

. To click the “Right button” of touch pad to setup the detail settings of the Wow video
scheme.

. There are 4 options to select in “Color Channel” Click on: Red, Green and Blue. Users can
set Gamma, Contrast and Brightness for each color channel separately.

Figure 9 : Video Scheme Details Dialog
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4.4 Depth Security Control

4.4.1 Entrance Guard

Scenario

This feature provides an auto logon mechanism to your MS Windows system by utilizing the
built-in webcam to recognize the face of users who intend to logon to the system. It secures the
exposure of the IDs and passwords, as well as to make the logon very easy and speedy.

Users power on the laptop and the system automatically enable the built-in webcam and its
database for a security check to see if the user has been authorized to allow to get into the
system or not.

Main Functions

There are 3 main applications in the function page there are Account Management, IM
Password Wizard and Advanced Feature.

Figure 10: Entrance Guard Dialog
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1. Account Management

(1) Create New Account
Users can manage the Entrance Guard accounts via this function. Users can use the
webcam to capture new faces, and then setup new security password to create new
user account.

(2) Delete Account
Users can delete the current running Entrance Guard account (Self-delete).

(3) Update Account
Users can update the information of current accounts, such as new face or new
security password.

Entrance Guard-Setup

Create New Account

Delete Account

Update Account

Figure 11: Account Management Dialog

2. IM Password Wizard

This function provides automatic and easy logon to 5 popular real-time web based
communicators, they are “Windows Live Message”, “Yahoo! messenger”, “Skype”, “ICQ”
and “QQ” by presetting the logon information within.

Entrance Guard-Setup

Windows Live Messenger

YAHOO!I Messenger

Skype

Ica

(a]s]

Figure 12: IM Password Wizard Dialog
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3. Advanced Settings

In this setting page, users can find more advanced information and settings for experienced
users.

(1) Password Management
Users can see what their preset logon information. Users can do some changes
including delete or correct field data.

(2) Option
Users can change the default setting on some preset Entrance Guard behaviors.

(3) Event log
Users can review the records of logon actions to verify dialog appear event. If the event
was successful, it only shows text to inform users. If the event was fail, it shows the face
image on the box below for demonstration.

Entrance Guard-Setup

Password Management
Option

Event log

Figure 13: Advanced Settings Dialog

Operation Procedure

Create New Account

1. Click on “Account Management”, screen will change to dialog below. (Figure 16), Click
on “Create New Account” You can start to create a new account
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Entrance Guard-Setup

Create New Account

Figure 14: Entrance Guard-Setup (1)

2. Input user’s windows password to create a new Account. Press “OK”. (Figure 17)

(Pa

e Vistad2-PC

® Standard User

Figure 15: Entrance Guard-Account Training dialog

3. Counting backwards for 5 seconds, System will catch the face information through the
webcam used as data of the account. (Figure 16)

4. When face capturing users’ faces must stay close to webcam and avoid rocking their faces in
order to catch the best image information.

5. In order to get the best result, users shall need to move their face in the yellow frame.

6. If the face image been detected well, the green square will appear and the webcam will
capture the face in the green frame.

7. Otherwise, the red frame will appear when face detection is unsuccessful. Users need to
keep moving their face for a best detect result.
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Figure 16: Entrance Guard Account Training Dialog

8. After face image verification, users will be asked to key-in the security password. (Figure
17)

Entrance Guard-Setup

Seowity Pavemord Setire

Frter Mgan o Ve

Figure 17: Security Password Setting Dialog

9. User can store the security password in the proper location. (Default or customized) (Figure
18)

Semmipe  [Smatiace Foml wm) o}

oo e [ v s ‘

Figure 18: Security Password Saving Dialog

After the whole new Entrance Guard account creation procedure has been completed, user can
click on the “Finish” button to saved and apply to the program. (Figure 19)
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Figure 19: Account Creation Finish Dialog

Delete Account
Click on “Delete Account”, Face Authentication will first detect face to verify user identity
and then delete account.

Face Authentication

on Starts

Security Pwd

Figure 20: Face Authentication Dialog

Update Account
Click on “Update Account” System will catch the face information through the webcam used
as data of the account again. (Figure 16)
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4.4.2 Smart Watchdog(Vista only)

Scenario

Smart Watchdog is a monitoring application that utilizes webcam function for extended service
to users.

By using the built-in webcam, the Smart Watchdog can detect the presence of the users for an
advanced power management and enhance the security of the data inside the laptop from

spying.

Main Functions

(1)

)

(3)

(4)

Monitoring

The Smart Watchdog will use webcam to detect if the users are still in front of system, if
users has been left for a certain period of time, the Smart Watchdog will tell system for
next instruction that user’s pre-defined.

Power Saving

Smart Watchdog can instruct system to go into either “Standby” or “Hibernation” by
following the user preset watching criteria to save the power for longer time operation.
Depends on the user using behavior, an average estimation around 10 % power saving
would be a reference.

Security Enhancement
Smart Watchdog secures the data from spying or illegal use on when the users are not
around.

Standby Time Setting
This feature is for setting the time period before system will go into Standby mode.

Sel System Slandby
15 seconds
15 seconds

30 seconds
45 seconds

es
5 minutes
Newver

B> Load Default

TR E
Figure 21: Smart Watchdog — System Standby Screen
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(5) Hibernate Time Setting
This feature is for setting the time period before system will go into Hibernate mode.

Figure 22: Smart Watchdog — System Hibernate Screen

Operation Procedure
1. Click on “Smart Watchdog” icon under “Smart Watchdog” folder and dialog shown.
2. The Smart Watchdog dialog appears for further feature selection.

3. To active the monitoring webcam, users can select to set either the time period for getting
into “Standby” or “Hibernate”.

4. The time period before go into Standby can be set from 15 seconds to 5 minutes in
7-segment settings. Users can also set the time as “Never”. (Refer to Figure 23)

5. The time period before go into Hibernate can be set from 1 minute to 10 minutes in
5-segment settings. Users can also set the time as “Never”. (Refer to Figure 24)
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4.4.3 Safety Guard

Scenario

This is a compound technology by the Video Tracing through webcam through Digital
Microphone. Safety only needs webcam and Microphone.

Users can utilize this feature for safety assurance or other monitoring applications.

Main Functions

1. Tracing Mode
After launch Safety Guard, it starts at the “Tracing” mode.

Figure 23: Safety Guard Tracing Mode

Press “JJil” button to start tracing process, Safety Guard begin to guard your properties. If
abnormal behavior is detected, Safety Guard starts to record and save the abnormal frames in
the storage.

Press n or n button can pause or stop the tracing process.

& 1 Normal: Set the tracing sensitivity to normal.
L High: Set the tracing sensitivity to high level.

n Time: Limit the length of the recording file.
Space: Limit the size of the recording file.
None: any limitation.
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2. View Records Mode
In “View Records” mode, user can review the abnormal files that were recorded at tracing

process.
The files are stored in the folder at “C:\Users\ {user accountj\Documents\Safety Guard\

AV Stream\”.

Satety Guard

Figure 24: Safety Guard View Records Mode

press “JE’” button to play the file, “Jll”” and “[lEM” button for user to pause or stop it.

1 Delete Button: Remove the item of the file list and delete it from storage.
Rename Button: Rename for the files.

3. Schedule Arrangement
“Schedule Arrangement” dialog for user to arrange the tracing schedule.

Safaty Guard

Schedule Arrangsment

Sensihvity
Nomnal

Figure 25: Safety Guard Schedule Dialog
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Q) Schedule List: List the tracing schedule items.
Delete button: Delete the item in schedule list.

Add New Schedule: To add new tracing schedule, set date, time, sensitive, and limit
condition, then press “Add to List” button.

4. Tracing Settings
Press “Tracing Settings” button then shows the “Settings” dialog This page for user to
change the following settings: recording setting, user mail setting and SMS setting.

Safety Guard

Settings

1 Display time markc [ Tum off manar [l Popup waming message

Use default

tpe l.com B This server requires authentication

Sender (EEEN N eddie_lee Ecompal.com
SMTF sever = cam Passvord  ELEIIILY

Fort

Update

Phane number  ETEVE R

Updste

Figure 26: Safety Guard Settings Dialog

@) Recording Setting
[ =4y . . . .
Record time mark: Add time mark on the video frame when recording.

Blank the monitor screen: Blank the monitor screen when start tracing.
Warning message: Pop up warning message when the abnormal frame detected.
Press the “Use default” button to enable all the three options.
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Sl

=y

User Mail Setting

Safety Guard provides e-mail notification. When abnormal behavior is detected, Safety
Guard will send a warning message with a snap to the designated e-mail address.

Recipient: E-mail address as the receiver of the mail.

Sender: Set the e-mail address as the sender of the mail.

SMTP server: Set the SMTP server for sending e-mail.

Port: Fill in the port number which is provided by the SMTP service provider.

SSL.: Check it if the server requires a secure connection.

Authentication: Fill in the username and password if the server requires authentication.
To save the changed settings, press the “Update” button.

SMS Setting

Safety Guard provides SMS notification. User can receive a short message by mobile
phone when the abnormal behavior is detected.

To save the changed settings, press the “Update” button.

To utilize SMS notification, user must have a Skype account first. And Skype must be
installed in the system.

For more information about Skype SMS, please refer to the Skype website
(www.skype.com).
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4.5 User Friendly

4.5.1 Wireless Switch

Scenarios

Users set the Wireless Switch preference. Only when Bluetooth and WLAN (802.11x) devices
both exist, users can adjust their preference.

_' Wireless Switch

A kI

Figure 27: Wireless Switch Configuration Dialog

Operation Procedure

(@D) *”)‘ Apply both Bluetooth and WLAN (802.11x) devices.

2 Apply Bluetooth device.

3 Apply WLAN (802.11x) device.

After selected, it will take effect by press “Enter” keyboard keypad immediately or
configurations will apply after 4 seconds.

You can also click the expected item by mouse cursor then it will apply the configurations
immediately.

If you want to turns off both devices, please switch the “kill switch™
If “kill switch™ turns off, both devices are all disabled.
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4.5.2 Meeting Secretary

Scenarios

To integrate and enhance the feature of built-in CMOS sensor and Array Microphone, a smart
service of on-line meeting has been designed for personal and conference audio/video
recording.

To enable for users to use the utilities of the video tracing of CMOS sensor and the voice beam
forming tracing of Array Microphone to create a virtual personal media office.

Meeting Secretary has two modes, Video Mode and Audio Mode, and each of them has unique
features. This section will briefly describe the behaviors of these features.

Single Mode
In this scenario, the webcam detects only one person in font of the PC. Meeting secretary will

adjust webcam and enable the beam forming function to capture video and audio. The
illustrations that describe the webcam and microphone behaviors are as below.

1. Webcam Behavior
In this scenario, the detected object will be zoomed and located in the center of the display
window. The webcam will automatically trace the object as it moves.

Figure 28: Webcam Behavior in Single Mode
(object zoomed to the center).

2. Microphone Behavior
In this scenario, Meeting secretary will enable microphone array functions including the
Beam Forming and Noise Suppression. These functions can filter static noise and room
reverberation.
The microphone array can always retrieve the front voice and filter out voices from other
directions.
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Multiple Modes

In this scenario, the webcam detects two peoples in front of the PC. Meeting secretary will
adjust webcam and enable beam forming function to capture video and audio. The illustrations
that describe the webcam and Microphone behaviors are as bellow.

1. Webcam Behavior
The Meeting secretary can separate different objects and display in each window. Each user
can be positioned in the center of an individual window of partial screen.

2. Microphone Behavior
In this scenario, Meeting secretary will enable the microphone array functions including the
Beam Forming and Noise Suppression. These functions can filter static noise and room
reverberation.
The microphone array can always retrieve the front voice and filter out the other direction
voices.

Main Functions

There are 5 stream recording modes to choose from the Main Dialog (see Figure 29).
There are Solo, Conference, Video, Video Tracing and Snapshot.

Meeting Secretary

Figure 29: Meeting secretary main dialog
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1. “Solo” Audio Recording

(1) Insolo audio recording mode, Meeting secretary enables Beam Forming and Noise
Suppression functions.

(2) The microphone array can automatically allocate and steer toward the sound object to
record it.

(3) Users can record their own voice through this function for voice message or reminder
usages.

(4) The recorded audio files are saved as “yymmdd-hhmmss.wma’ and kept in
“...\User\Documents\Meeting secretary\AudioSolo\” folder

“Conference” Audio Recording

(1) Users are able to record the conversation in the conference.

(2) All sound recorded without the Beam Forming and Noise Suppression functions.

(3) The recorded audio files are saved as “yymmdd-hhmmss.wma’ and kept in *...
\User\Documents\Smart Meeting\AudioConference\” folder.

ol ‘\/ideo” Recording
(1) The “Video” function will record both sound and image without any advanced tracing
function.
(2) The recorded audio files are saved as “yymmdd-hhmmss.wmv’ and kept in *...
\User\Documents\Meeting secretary\VideoConference\” folder.

“Video Tracing” Recording

(1) “Video Tracing” enables the auto tracing function to the objects (users’ faces) in front
of the webcam lens.

(2) In Single Mode, when object moved, the lens will follow to get the best fit image
captured onto the center of the video dialog.

(3) In Multiple Modes, the video dialog screen will be divided into sub-dialogs, while
multiple objects had been detected in front of the lens. The lens will also trace to get the
best fit images and put on the center of the each video dialog.

(4) The recorded audio files are saved as “yymmdd-hhmmss.wmv” and kept in “...
\User\Documents\Meeting secretary\VideoSolo\” folder.

yy: Year
mm : Month
dd: Date.
hh: Hour
mm : Minute
ss: Second.
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Operation Procedure
Player Control
e

1. Previous Button

2 3 4 5 6 7

Figure 30 : control buttons

When playing the recorded clip or browsing captured image, user can press this button to
stop current action and leap to the previous one and continue to execute the same function
on this clip or image.

2. Stop Button

When playing the recorded clip or browsing captured image, users can press this button to
stop current action.

3. Record Button

Users can press this button to start recording the video streams according to the settings in
the current mode. When recording, the volume will be muted. Users can also press this
button or other play control buttons to stop the recording action.

4. Play Button
Users can press this button to play, pause or replay current file.

5. Next Button

When playing the recorded clip or browsing captured image, users can press this button to
stop current action and leap to the next one and continue to execute the same function on this
clip or image.

6. Mute Button

Users can press this button to mute the volume output or release it. This function will be
automatically disabled while Meeting secretary is recording.

When the status is at mute, users can press this button or other volume control buttons to
disable and change the volume level.

7. Volume Control Bar

Users can control the volume level via sliding the control bar left or right.
When volume status is mute, users can also slide this bar to release it.

4-28



4 Innovative Product Feature

0}

Web CAM
sellings

Webcam Settings

Users can change the webcam settings according to the preference of users. The property page
below is provided with webcam driver.

VCapture Properties (=]
Settings ‘
Image Confral O elault
I Irnage Miree I™ ImageFlip ) Dﬂ"’“hJ
Sawe
Brightress [ —— ———— El 4
Lead
Conlrast j | o
Gama |~ F @ )
g Flicker
ol € Outdoor
Satuafion | T b & BIHz
Shapress 60  BOHz
—_—_
Extra Control
Backight
Aule Made Corol [ cumug
AUTd
_— = ™ B/ Mods
‘whiteB alence
Estrs Cortral 2
—
i r
[r—
* [~ Privacy
oK Cancel | |

Figure 31 : The Property Page of Webcam

¢

Micmbhone
sellings

Audio

Users can change the microphone settings according to the preference of users. The property
page below is provided with audio driver.
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File List and E-Mail

Properties

AudiolnputMixer Properties j
Master Input Mix
_'_

=

-
-
-

Pin Line Input Mox
f—

p—
f—

Pin Line:

Master Volume  ~

ok |

Cancel |

Figure 32 : The Property Page of Audio

Users can quickly attach the photos, audio or video files that are selected in the file list to

E-mail and sent out.

Snapshot

Snapshot

Users can press this button to take a picture. Obviously, this button enables only in Video

mode.
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5 Caring for Your Notebook

5.1 Caring for Your Notebook

> Cleaning Your Notebook and Keyboard
Cleaning the Display
Cleaning the Touch Pad

Cleaning the CD/DVD Drive

vV V VvV V

Precautions

Never spray cleaning products directly onto your notebook’s case or display. Only
use products designed for cleaning computer displays.
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5.1.1 Cleaning Your Notebook and Keyboard

1.

Shut your notebook down, turn it off and disconnect it from the electrical outlet and any
external devices, such as the printer.

Remove the battery pack.

Use the brush attachment of your vacuum cleaner to gently remove dust from your
notebook’s openings and keyboard.

Use a slightly moistened soft, lint-free cloth to wipe your notebook and keyboard. Use
only the water or the recommended computer cleaner.

5.1.2 Cleaning the Display

1.

Shut your notebook down, turn it off and disconnect it from the electrical outlet and any
external devices, such as the printer.

Remove the battery pack.

Use a slightly moistened soft, lint-free cloth to wipe your notebook’s display. Use only
the water or the recommended computer cleaner.

5.1.3 Cleaning the Touch Pad

1.

Shut your notebook down, turn it off and disconnect from the electrical outlet and any
external devices, such as the printer.

Remove the battery pack.

Use a slightly moistened soft, lint-free cloth to carefully wipe the Touch Pad, being
careful not to allow the moisture into the gaps of your notebook. Use only the water or
the recommended computer cleaner.

5.1.4 Cleaning the CD/DVD Drive

& Never touch the lens. Use only the compressed air to clean the lens.

If you encounter the difficulty in playing CDs or DVDs, including skipping over, please
clean the unlabelled side of the disc with a soft, lint-free cloth or use the commercial
product.
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5.1.5 Precautions

Do not spill the liquid on the keyboard. If the liquid is spilt on the keyboard, turn
your notebook off immediately. Leave off overnight to let it completely dry out
before using it again.

Do not turn off your notebook if the drive light indicates the drive is active.
Turning off your notebook while it is reading from or writing to a disk may
damage the disk, the drive, or both.

Keep your notebook and disks away from the objects that generate the strong
magnetic fields, such as the stereo speakers. Information on disks is stored
magnetically. Placing the magnet too close to the disk can erase the important
files.

Scan all new files for viruses. This precaution is especially important for the files
you receive via email, disk or download from the Internet. You will need the
special program to scan for viruses. For further information, please contact with
your notebook dealer.

To ensure HDD function and the integrity of the saved data, please follow the
instructions below:

€ Protect your notebook from any impact during its operation.
€ Do not use your notebook during the transportation such as in the car.

€ Do not put your notebook in the car if it is directly exposed under the
sun.

€ Do not place any heavy objects on the LCD monitor.

€ Use the AC adapter coming with the package instead of other adapters.

5-3



5 Caring for Your Notebook

5.2 Traveling

YV V V V

Identifying Your Notebook
Packing Your Notebook
Traveling Tips

If Your Notebook is Lost or Stolen
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5.2.1 Identifying Your Notebook

Attach a nametag or business card to your notebook, or use the permanent marker or stencil
to write a unique identifying mark (such as your driver’s license number) on the case.

Create a file on the Desktop called if found. Place information such as your name, address,
and telephone number in this file.

Contact your credit card company to ask if it offers coded identification tags.

5.2.2 Packing Your Notebook

Remove any external devices attached to your notebook and store them in a safe place.
Fully charge the main battery and any spare batteries you plan to carry with you.

Turn off your notebook or put the computer into hibernate mode.

Disconnect the AC adapter.

Remove any extraneous items, such as paper clips, pens, and papers, from the keyboard
and then close the display.

Pack your notebook and accessories in their carry case.

Avoid packing the computer with items such as shaving cream, colognes, perfumes, or
food.

Protect your notebook, the batteries, and the hard drive from hazards such as extreme
temperatures, dirt, dust, liquids, or overexposure to sunlight.

Pack your notebook so that it does not slide around in the trunk of the car or in an
overhead storage compartment.

& When traveling in the air, never check in your notebook as baggage.
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5.2.3 Travel Tips

If you are traveling abroad, you can carry the proof of ownership—or of your
right for using your notebook if it is company-owned—to speed your passage
through customs. Investigate the customs regulations of the countries you plan to
visit and consider acquiring an international carnet (also known as a
merchandise passport) from your government.

Ensure that you know which electrical outlets are used in the countries you will
visit, and prepare the appropriate power adapters.

Check with your credit card company for information about any kinds of
emergency travel assistance it offers to the users of the portable computers.

When traveling in the air, please ensure that you have a charged battery available
in case you are asked to turn on your notebook.

Before using your notebook on the airplane, please verify that such usage is
permitted. Some airlines forbid the use of electronic devices during the flight.
All airlines forbid the use of electronic devices during taking-off and landing.

& Never pass your notebook through a metal detector. Send it through an X-ray
machine, or have it manually inspected.

5.2.4 If Your Notebook is Lost or Stolen

Call a law enforcement agency to report your notebook lost or stolen. Ask that a case
number be assigned and write down the number, along with the name, address, and
telephone number of the law enforcement agency. If possible, please obtain the name of the
investigating officer.

If your notebook belongs to the company, notify its security office.
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6 Peripherals

6.1 Express Cards
> Express Card Types
> Installing a Express Card

> Removing a Express Card
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6.1.1 Express Card Types

The New Card slot supports one 54mm type Express Card. It supports both USB 2.0 and
Express technology which improve the speed in data transfer and require less power than
PC Cards.

= . .
. A Express Card is not a bootable device.
Q

6.1.2 Installing a Express Card

Express Cards, with hot-plug feature, allow you to install and remove cards when your
notebook is running. The card will be detected automatically after being installed.

Usually Express Cards have a mark or symbol to show which end to insert into the slot.
Insert the card according to the orientation symbol, and slide the card into the slot. Check
the documents that came with your card if the orientation is unclear.

1. Press to release the dummy card from the New Card slot.

2. Hold the Express Card with its orientation symbol pointing into the slot and the topside
of the card facing up.

Slide the card into the slot until it clicks into the connector.

If you encounter too much resistance, do not force the card. Check the card orientation
and try again.
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6.1.3 Removing a Express Card

T -

1. Push the card all the way to and then release it.
2. Pull the card out of the slot.
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6.2 Adding and Removing SD/MMC/MS Cards

Before removing an SD/MMC/MS card, stop it running from the configuration
utility on the taskbar. Failure to do so could result in the data loss.

Insert the SD/MMC/MS card into the card reader slot.

To remove the SD/MMC/MS card, please push it in gently and then it ejects automatically.
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6.3 Memory Modules

You can add more memory modules to your notebook to improve its performance.

To install a memory module:

3.
4
5.
6. There are two memory module ports. The current memory module in your notebook

Make sure the computer is turned off.
Remove the screw securing the memory module cover.
Lift off the memory module cover.

already occupies the one. Place the new memory module in the second slot, matching
up the notch along its connector rim with the tooth in the connection slot.

When the module is secured, please press down gently until it snaps into place.

Depending on how much additional memory you require, you may need to replace
the original memory module.

To remove a memory module:

1.

2.
3.
4

6-5

Make sure the computer is turned off.
Remove screw securing the memory module cover.
Lift off the memory module cover.

Pop out both silver latches holding the memory module into place. The module pops
up.

Grasp the outer edges of the memory module with the thumb and forefinger, and then
gently remove it.
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7.1 Power Management
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SpeedStep



7.2 Managing Your Notebook’s Power

'Q] See 0 7.3 Battery for more information on getting the best performance from the
battery packs.

'Q] Use your notebook connected to an electrical outlet as often as possible as the
battery life expectancy is affected by the number of times it is charged.

Your notebook comes with built-in power management. You can configure it
through the Power Options program in the Control Panel, to sleep, hibernate, and
wake according to the specific situations.

The Advanced settings can be accessed via Start > Control Panel > System and
Maintenance > Power Options.

On the Select a power plan page, click Change plan setting under the plan that
you want to change.

Click Change advanced power settings. Expand the Power buttons and lid
category to configure the settings.

When leaving your notebook unattended for the long period, place it in Standby or
Hibernate Mode. You can exit either power management mode by pressing the
Power Button.

7.2.1 Power Management Modes

7.2.1.1 Sleep Mode

This mode conserves power by switching off the hard drive and display after the
preset period of inactivity (a time-out). When Sleep Mode is exited, your notebook
will return to the same operating state it was before entering sleep.

In Sleep Mode, if your notebook loses power from both of the electrical outlet and
the battery, the data in your notebook may be lost.

To enter Sleep Mode in Windows Vista:
Start > P> > Sleep. Or
Set your notebook to enter Sleep Mode ,as you:

e Close the lid of your notebook
e Press the power button

e Press the start menu power button

The settings can be accessed via Power Options: Advanced settings window. See
0 7.2 Managing Your Notebook’s Power.

To exit Sleep Mode, please press the Power Button. You cannot exit Sleep Mode
by using any key or the Touch Pad. For more information on Sleep Mode, see 0 2.1
Turning Your Notebook On and Off.
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7.2.1.2 Hibernate Mode

In Hibernate Mode, power is conserved by system data being copied to the hard
drive, and your notebook is completely shut down. While Hibernate Mode is exited,
your notebook will return to the same operating state it was in before entering
Hibernate Mode.

Hibernate Mode can be enabled/disabled in the Power Options window.

Your notebook will go into Hibernate Mode if the battery charge level becomes
critically low.

Depending on how you set the Power Management Options in the Power Options
window, use one of the following methods to enter Hibernate Mode:

e Close the lid of your notebook
e Press the power button
e Press the Start menu power button

e Start > P> > Hibernate.

The settings can be accessed via Power Options: Advanced settings window. See
0 7.2 Managing Your Notebook’s Power.

To exit Hibernate Mode, press the Power Button. You cannot exit Hibernate
Mode by using any key or the Touch Pad. For more information about Hibernate
Mode, see 0 2.1 Turning Your Notebook On and Off.

7.2.2 Power Options Properties

To access the Windows Power Options window:
Start > Control Panel > System and Maintenance > Power Options

7.2.2.1 Select a power plan

Windows Vista provides three preset power plans-Balanced, Power saver, and High
performance. Each plan has the different time-out settings for turning off the display
and entering Sleep Mode. You do not need to make any further adjustments to set
the performance level.

To change setting for the plan, click the following three items on the left pane of the
Power Options window.

e Choose when to turn off the display
e Change when the computer sleeps

e Adjust the display brightness

After selecting a plan, you can see the percentage of battery charge remaining and
active power plan by moving the mouse pointer over the battery meter icon on the
taskbar.
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For more information on changing advanced power settings, see the Windows Help
and Support.

’Qj To maximize battery power, use the Power saver plan.
[

7.2.2.2 Power buttons and password protection

Select Require a password on wakeup, Choose what the power buttons does, or
Choose what closing the lid does from the left pane of the Power Options window.
There are two main settings in this section:

e Power button and lid settings

e Password protection on wakeup

Depending on your operating system, program the following functions by clicking
an option from the corresponding pull-down menu in Advanced settings window,
and then clicking OK to save your settings and close this window.

For more information on accessing the Advanced settings window, see 0 7.2
Managing Your Notebook’s Power.

e Set the computer to Do nothing / Sleep / Hibernate / Shutdown when
you press the power button.

e Set the computer to Do nothing / Sleep / Hibernate / Shutdown when
you close the laptop lid

e Select the password requirement when the computer wakes from sleep.

7.2.2.3 Create a power plan

Besides three preset power plans offered in Windows Vista, you can also customize
your own power plan. Select Create a power plan on the left pane of the Power
Options window to begin configuring your power settings.

7.2.3 SpeedStep

Your notebook is equipped with SpeedStep technology to better manage power
consumption. It changes the processor speed to find the best balance between your
computing performance and power consumption needs. Higher speeds bring better
performance, but the slower speed conserves more power.

In Windows Vista, the processor’s performance level depends on the Power
Scheme you select (see 0 7.2.2 Power Options Properties). You do not need to make
any further adjustments to set the performance level. Each preset power scheme has
different time-out settings for entering Sleep Mode, Hibernate Mode, shutting down
the display, or turning off the hard drive.
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For example, the Windows Vista automatically changes SpeedStep Modes
depending on running the AC power or batteries in order to prolong the battery
usage while still providing optimal performance.

You can also individually alter and save each of these settings and schemes if
desired. Choose from the following three power plans that describe the desired
relationship between power and performance.

[E=3|Eol )
@uv|@ <« Power Options » Create a Power Plan - | 3 | | Search 2|

Create a power plan

To create your own plan, start by selecting one of the following plans that is closest to what you want.

(@ Balanced Battery life: @29
Automatically balances performance with energy consumption on capable  Performance: @99
hardware.

() Power saver Battery life: eooooe
Saves energy by reducing your computer's performance where possible. Performance: @@

1 High pefformance Battery life: @@
Favors performance, but may use moere energy. Performance: 999099

Plan name:

My Custom Plan1

Mext Cancel

Windows Vista automatically chooses the SpeedStep Mode to find the most
appropriate speed for your processor according to the type of plan you choose and
your current system demands.
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7.3.1 Battery Performance

The Battery Performance can be varied with on the different operating conditions.
Your battery may last less time if you are running power-intensive programs,
playing CDs or DVDs, or setting the high display-brightness.

The Power Management Options can be set to alert you when the battery charge is
low.

Ensure any battery you use is compatible. Failure to do so may risk fire or
explosion. For more details on purchasing compatible batteries, please contact
your notebook retailer.

Batteries should never be disposed of the household waste. Contact your local
waste disposal or environmental agency for advice on disposing of the used
lithium-ion batteries.

7.3.2 Checking the Battery Charge

Battery Status Indicator behavior

Charging Flashes blue

Fully Charged || Solid blue

Critical Low Amber > approximately 3 minutes left; system beeps

7.3.3 Power Meter

The power meter M indicates the remaining battery charge. When your notebook is

running on battery power, you can double click the E icon on the taskbar to check
the remaining battery charge. If you want to know more details about how to make
the icon appear on the taskbar if it is not already, please see 0 7.1 Power
Management.
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7.3.4 Low-Battery Warning

After a low-battery warning, save your work immediately and then connect your
notebook to an electrical outlet. Hibernate Mode will begin automatically if the
battery runs completely out of power.

You will hear the low-battery warning when the battery charge is approximately 90
percent depleted. Your notebook will beep once, indicating approximately 10 to 15
minutes of battery operating time remain. If you do not connect your notebook to
alternative power source during that time, there will be a periodic beep. Your
notebook will automatically enter Hibernate Mode if battery charge reaches a
critically low level. For more information, see 0 7.1 Power Management.

7.3.5 Charging the Battery

'Q1 When connected to an electrical outlet, a completely discharged 6 cell battery
needs to be charged in 3.5 to 12 hours, and a 9 cell battery in 4.5 to 12 hours
(depending on whether your notebook is on or off and what programs are running).
You can leave the battery in your notebook as long as you like. The battery’s
internal circuitry prevents the battery from overcharging.

Before using the battery for the first time it must be charged. Connect your notebook
to an electrical outlet and allow the battery to fully charge, indicated by the battery
indicator light on the front panel of your notebook.

'Q] Once a battery pack is fully charged for the first time, please use your notebook on
battery power until the battery discharges completely. This will extend the battery
life, and helps to ensure the accurate monitoring of the battery capacity.

If necessary, the battery will be charged whenever your notebook is connected to an
electrical outlet.

The battery will not be charged if it or your notebook is too hot to use. If this
situation occurs, the battery indicator will light amber. Disconnect your notebook
from any electrical outlet, and allow it and the battery to cool down. You can then
reconnect your notebook to the electrical outlet and charge the battery. The battery
indicator will also light amber if the battery is bad and needs replacing.

7.3.6 Removing the Battery

Before removing the battery, ensure your notebook is turned off.
1. Move the battery lock to switch to the right (Unlock position).
2. Slide and hold the battery to release latch.

3. Remove the battery.
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7.3.7 Installing a Battery

1. Slide the battery into the bay.
2. Press it into place gently but firmly until the latch locks it into place.
3. Slide the battery lock to switch back to the locked position.

7.3.8 Storing a Battery

If storing your notebook for an extended period of time, please remove the battery.
Fully charge the battery before using your notebook again.

7.3.9 Working With Extra Battery Packs

If you spend a lot of time traveling or work without connecting your notebook to an
electrical outlet, it may be a good idea to carry the additional battery packs so you
can quickly replace a discharged battery and continue working.

7.3.10 Maximizing Battery Life

A battery can be recharged many times, but over time it will lose its ability to hold a
charge. To maximize the battery life:

e If you are not using your notebook for a long period, please remove the
battery.

e If you have a spare battery pack, please alternate the batteries.
e Ensure your notebook is off when replacing the battery.

e Store the spare battery packs in a cool, dry place, out of the direct
sunlight.
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8.1 Power Management
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8 The Power System (XP)

8.1.1 Managing Your Notebook’s Power

See 0 8.2 Battery for more information on getting the best performance from battery
packs.

e

Use your notebook connected to an electrical outlet as often as possible as battery
life expectancy is affected by the number of times it is charged.

4

Your computer comes with built-in power management. You can configure it, through the
Power Options program in the Control Panel, to sleep, hibernate, and wake according to
specific situations.

When leaving your notebook unattended for long periods, place it in standby or hibernate
mode. You can exit either power management mode by pressing the power button.

8.1.2 Power Management Modes

8.1.2.1 Standby Mode

This mode conserves power by switching off the hard drive and display after a preset period
of inactivity (a time-out). When standby mode is exited, your notebook will return to the
same operating state it was before entering standby.

. Ifyour notebook loses power from both the electrical outlet and the battery while in
- standby mode, data may be lost.

To enter standby mode in Windows XP:
Start > Turn off computer > Stand By. Or
Set your notebook to enter Standby mode:

e When you close the lid of your notebook
e When you press the power button

e When you press the sleep hot key

The settings can be accessed via the Advanced tab in Power Options Properties (Start >
Control Panel > Pick a category > Performance and Maintenance > Power Options).

To exit standby mode, press the power button. You cannot exit standby mode by pressing a
key or the Touch Pad. For more information on standby mode, see 0 3.1 rning Your
Notebook On and Off.
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8.1.2.2 Hibernate Mode

In Hibernate mode, system data is copied to the hard drive, and your notebook is completely
shut down to save power. When exiting Hibernate mode, your notebook returns to the same
operating state it was in before entering Hibernate mode.

Hibernate mode can be enabled/disabled in the Power Options Properties window.

If enabled, your notebook will enter Hibernate mode if the battery charge level becomes
critically low.

Depending on how you set the Power Management Options on the Advanced tab in the
Power Options Properties window, use one of the following methods to enter hibernate
mode:

e When you close the lid of your notebook
e When you press the power button
e When you press the sleep hot key

e Start > Turn Off Computer > Hibernate (if the Hibernate option does not
show, press Shift, and the Standby option will switch to Hibernate).

If the Hibernate option is not available for these methods, Hibernate mode has not been
enabled. Check the Enable hibernation box on the Hibernate tab of the Power Options
Properties window and click Apply to enable Hibernation.

To exit Hibernate mode, press the power button. You cannot exit Hibernate mode by
pressing a key or the Touch Pad. For more information on hibernate mode, see 0 3.1 rning
Your Notebook On and Off.
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8.1.3 Power Options Properties

To access the Windows Power Options Properties window:
Start > Control Panel > Pick a category > Performance and Maintenance > Power
Options

8.1.3.1 Power Schemes Tab

The Power Schemes pull-down menu in the Power Options Properties displays the selected
preset power scheme.

To maximize battery power, use the Portable/Laptop power scheme.

Y

In Windows XP the processor's performance level depends on the power scheme you select.
You do not need to make any further adjustments to set the performance level. Each preset
power scheme has different time-out settings for entering standby mode, hibernate mode,
turning off the display, and turning off the hard drive. For more information on power
management options, see the Help and Support Center.

8.1.3.2 Alarms Tab

Enable audible alarms by clicking each Alarm Action button and selecting Sound
alarm.

4

The Low battery alarm and Critical battery alarm settings alert you when the battery charge
falls below a certain percentage.

When you receive your notebook, the Low battery alarm and Critical battery alarm check
boxes are selected. See 0 8.2 Battery for more information on low-battery warnings.

8.1.3.3 Power Meter Tab
Displays the current power source, battery status, and charge amount.
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8.1.3.4 Advanced Tab
With the Advanced tab you can:

= Set power icon and standby mode password options.

= Depending on your operating system, program the following functions by clicking an
option from the corresponding pull-down menu, and then clicking OK.

Set the computer to Stand by / Hibernate / Do nothing when you close the
laptop lid

Set the computer to Ask me what to do / Stand by / Hibernate / Shut down /
Do nothing when you press the power button.

Set the computer to Ask me what to do / Stand by / Hibernate / Shut down /
Do nothing when you press the sleep hot key.

8.1.3.5 Hibernate Tab

The Hibernate tab lets you enable hibernate mode by clicking the Enable hibernation
check box.
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8.1.4 SpeedStep

Your notebook is equipped with SpeedStep technology to better manage power
consumption. It changes the processor speed to find the best balance between your
computing performance and power consumption needs. Higher speeds enjoy better
performance, while slower speeds conserve more power.

In Windows XP, the processor's performance level depends on the Power Scheme you select
(see 0 8.1.3 Power Options Properties). You do not need to make any further adjustments to
set the performance level. Each preset power scheme has different time-out settings for
entering standby mode, hibernate mode, turning off the display, and turning off the hard
drive.

For example, the Portable/Laptop mode automatically changes SpeedStep modes
depending on if you are running the computer on AC power or batteries in order to prolong
battery usage while still providing optimal performance.

You can also individually alter and save each of these settings and schemes if desired.

Power Options Properties

Power Schemes | Alams || Power Meter | Advanced || Hibemate
. Select the power scheme with the most appropriate settings for
L this computer. Mote that changing the settings below will modify
the selected scheme.
Power schemes
Home/Cffice Desk L
Home /Cffice Desk
:Portable/| aptop
Presentation
Always On
Minimal Power Management
Max Batteny
When computer is: (%E;: Pluggedin I ranmng T
batteres
Tum off monitar: |_-'l:f-ter 20 ming w | |.-'lﬂer 5 ming w |
Tum off hard disks: | Mewver W | |.-'lﬂer 10 mins w |
System standby: | Mewver v | | Mewer A |
System hibemates: | Mewver W | |.-'lﬂer 15 mins w |
| ok || cencel || ooy |

Windows XP automatically chooses the SpeedStep mode to find the most appropriate speed

for your processor according to the Power Scheme you choose and your current system
demands.
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8.2.1 Battery Performance

The performance of the battery can vary, depending on operating conditions. Your battery
may last less time if you are running power-intensive programs, playing CDs or DVDs, or
have high display-brightness settings.

The Power Management Options can be set to alert you when the battery charge is low.

é

notebook retailer.

Ensure any battery you use is compatible. Failure to do so may risk fire or
explosion. For more details on purchasing compatible batteries, contact your

. Batteries should never be disposed of with household waste. Contact your local

é

Only use the BATEL80L6 or BATFL91L6 battery pack with this computer

8.2.2 Checking the Battery Charge

waste disposal or environmental agency for advice on disposing of used lithium-ion
batteries.

Battery Status Indicator behavior
Charging Flashes blue
Fully Charged || Solid blue

Critical Low

Amber > approximately 3 minutes left; system beeps

8.2.3 Power Meter

The power meter ' indicates the remaining battery charge. When your notebook is
running on battery power, you can check the remaining battery charge, double click

the ‘ icon on the taskbar. For more details, including how to make the icon appear on the
taskbar if it is not already, see 0 8.1 Power Management.
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8.2.4 Low-Battery Warning

. After a low-battery warning, save your work immediately, then connect your
- notebook to an electrical outlet. Hibernate mode will begin automatically if the
battery runs completely out of power.

You will hear the low-battery warning when the battery charge is approximately 90 percent
depleted. Your notebook will beep once, indicating approximately 10 to 15 minutes of
battery operating time remain. If you do not connect your notebook to alternative power
source during that time, there will be a periodic beep. Your notebook will automatically
enter Hibernate mode if battery charge reaches a critically low level. For more information,
see 0 8.1 Power Management.

8.2.5 Charging the Battery

When connected to an electrical outlet, a completely discharged 6 cell battery
needs to be charged in 3.5 to 12 hours, (depending on whether your notebook is on
or off and what programs, if any, are running). You can leave the battery in your
notebook as long as you like. The battery’s internal circuitry prevents the battery
from overcharging.

e

Before using the battery for the first time it must be charged. Connect the computer to an
electrical outlet and allow the battery to fully charge, indicated by the battery indicator light
on the front panel of the notebook.

Once a battery pack is fully charged for the first time, use your notebook on battery
power until the battery discharges completely. This will extend battery life, and
helps ensure accurate monitoring of battery capacity.

4

If necessary, the battery will be charged whenever your notebook is connected to an
electrical outlet.

The battery will not be charged if it or your notebook is too hot, either from use or being in
a hot environment. If this occurs, the battery indicator will light amber. Disconnect your
notebook from any electrical outlet, and allow it and the battery to cool to room temperature.
You can then reconnect your notebook to the electrical outlet and charge the battery. The
battery indicator will also light amber if the battery is bad and needs replacing.

8.2.6 Removing the Battery

Before removing the battery, ensure your notebook is turned off.
4. Move the battery lock switch to the right (Unlock position).
5. Slide and hold the battery release latch.

6. Remove the battery.
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8.2.7 Installing a Battery

7. Slide the battery into the bay.
8. Press it into place gently but firmly until the latch locks it into place.
9. Slide the battery lock switch back to the locked position.

8.2.8 Storing a Battery

If storing your notebook for an extended period of time, remove the battery. Fully charge the
battery before using your notebook again.

8.2.9 Working With Extra Battery Packs

If you spend a lot of time traveling, working without connecting your notebook to an
electrical outlet, it may be a good idea to carry additional battery packs so you can quickly
replace a discharged battery and continue working.

8.2.10 Maximizing Battery Life

A battery can be recharged many times, but over time it will lose its ability to hold a charge.
To maximize battery life:

e If you are not using your notebook for a long period, remove the battery.
e If you have a spare battery pack, alternate the batteries.
e Ensure your notebook is off when replacing the battery.

e Store spare battery packs in a cool, dry place, out of direct sunlight.
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9 The BIOS Setup Program

9.1 Introduction

The BIOS (Basic Input and Output System) Setup program is a menu driven utility that
enables you to make changes to the system configuration and tailor the operation of your
notebook to your individual work needs. A ROM-based configuration utility displays the
system’s configuration status and provides you with a tool to set system parameters. These
parameters are stored in nonvolatile battery backed-up CMOS RAM, which saves this
information even when the power is turned off. When the computer is turned back on, the
system is configured with the values found in CMOS. Via easy-to-use menus, you can
configure such items as:

=  Boot devices

The settings made in the Setup program intimately affect how your notebook performs. It is
important, therefore, to first understand all the available options, and second, to make
settings appropriate for the way you use your notebook. This chapter guides you through the
Setup program by providing the clear explanations for all Setup options.

A standard configuration has already been set in the Setup program by the factory
technicians. However, eventually you may want to customize your system to suit your own
performance needs. It is recommended that you read this chapter and become familiar with
the configurations that can be made in the BIOS.

The next section explains how to move around in the Setup program, as well as how to
specify and save your new settings. A brief discussion of the optional settings among the
different submenus follows.
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9.2 Navigating through the BI10OS Setup Program
> Accessing the BIOS Setup Program
> Launching Submenus

> Saving Changes and Exiting the Setup
Program

The Setup program has been designed to make it as easy to use as possible. It is a menu
driven program, which means you can scroll through the various directories and make your
selections among the various predetermined choices. If you accidentally configure a setting,
use the BIOS hot keys to return to the previous value. The hot keys are discussed in more
detail later in this chapter.

When turning on your notebook for the first time you may be prompted to run the BIOS
Setup program. A warning message may appear on the screen if the hardware configuration
is changed or the POST fails. This message will inform you of any errors or invalid settings
and prompt you to run the Setup program to correct the problem.

Even if you are not prompted by a message instructing you to use the Setup program, at
some time in the future you may want to change the configuration of your notebook. It will
then be necessary to reconfigure your system using the Setup program so that your
notebook can recognize these changes.

The list below gives a few examples of reasons why you may want or need to run the BIOS
Setup program.

= You have set up your notebook for the first time and you got a message stating that you
should run the BIOS Setup program.

= You want to redefine the communication ports to prevent any conflicts.

@ The few examples listed above are by no means complete.

9-2



9 The BIOS Setup Program

9.2.1 Accessing the BIOS Setup Program

To access the BIOS Setup program, press the [F2] key as soon as your notebook starts up.
The Phoenix BIOS screen will display.

Phoenix SecureCore(tm) Setup Utility
Main  Boot  Exit
Item specific Help

System Time: [19:34:35] <Tab>, <Shift-Tab>, or
System Date: [12/29/1995] <Enter> selects fields.
Product Name: XXX XXXX
Serial Number: XXXXXXXX

XXXXXXXX
System Memory: XXX KB
Extended Memory: XXX MB
BIOS Version: XXX
UUID Number: XXXXXXXX

XXXXXXXX
F1 Help ™ Select Item F5/F6 Change Values F9 Setup Defaults
Esc Exit <— Select Menu Enter Select » Sub-Menu F10  Save and Exit

The Menu Bar
The top of the Setup screen has a menu bar with the following selections:

Main Allows the user to specify standard IBM PC AT system parameters.

Boot

Exit

Allows the user to specify the order in which your notebook is to check
for a device to boot the system.

Allows the user to save CMOS setting and exit Setup.
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To move between menu bar items, use the <—— and — arrow keys until the desired
item is highlighted. For example, if you want to move from the Main menu to the Advanced
menu, press the right arrow key —— once.

Item Specific Help

To the right of the Setup screen, you will notice an item specific help bar. For each item that
you select on the menu, the bar informs of its specific function as well as the hot keys related
to that item and/or submenu.

9.2.2 Launching Submenus

A submenu contains the additional options for a field parameter. To call up a submenu,
simply move the highlight to the desired field and press the [Enter] key. The submenu
opens.

If you are a first time user or are not familiar with BIOS Setup program, it is highly
recommended that you take a few minutes to familiarize yourself with each of the submenus
and their corresponding functions. If you accidentally make unwanted changes to the
current configuration, go to the Exit menu and select Discard Changes.

9.2.3 Saving Changes and Exiting the Setup Program

Refer to the Exit Menu section of this chapter for the detailed information on saving
changes and exiting the Setup program.
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9.3 The Main Menu

When the Setup program is accessed, the Information screen appears. It displays the
following pieces of information regarding your current system:

System Time:

System Date:

Product Name:

Serial Number:

System Memory:

BIOS Version:

UUID Number:

F1 Help
Esc Exit

Extended Memory:

Phoenix SecureCore(tm) Setup Utility
Main  Boot Exit

[19:34:35]
[12/29/1995]

KXXXXXXX
XXXXXXXX

XXXXXXXX

XXX KB
XXX MB

XXX

XXXXXXXX
KXXXXXXX

™ Select Item F5/F6 Change Values F9 Setup Defaults

«—> Select Menu

Item specific Help
<Tab>, <Shift-Tab>, or

<Enter> selects fields.

Enter Select » Sub-Menu F10 Save and Exit

System Time and System Date

The hour is displayed with 24-hour format. The values set in these two fields
take effect immediately.

System Memory

This field reports the memory size of system base memory.

Product Name

This field displays the platform product name.

Serial Number

This field displays the platform serial number.

Extended Memory

This field reports the memory size of the extended memory with an integer in
the system, but 32Bit SMI will occupy 1 MB and UMA frame buffer (Integrated
VGA uses only).
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Extended Memory size = Total memory size — 1 MB — 1 MB — UMA frame
buffer

BIOS Version

This field displays current version of the BIOS.
UuID

This field displays the platform UUID number.
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9.4 The Boot Menu

This menu allows the user to decide the order of boot devices to load the operating system.
Bootable devices include the diskette drive in module bay, the onboard hard disk drive and
the CD-ROM in module bay.

Phoenix SecureCore(tm) Setup Utility

Main  Boot  Exit
Item specific Help

Boot priority order:

o XN @ g R bR

Excluded from boot order:

F1 Help ™ Select Item F5/F6 Change Values F9 Setup Defaults

Esc Exit «—> Select Menu Enter Select » Sub-Menu F10 Save and Exit
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9.5 The Exit Menu

Phoenix SecureCore(tm) Setup Utility
Main  Boot  Exit
Item specific Help
Exit Saving Changes Exit System Setup and
Exit Discarding Changes save your changes to CMOS.
Load Setup Defaults
Discard Changes

Saves Changes

F1 Hel ™ Select Item F5/F6 Change Values F9 Setup Defaults
p g p

Esc Exit <—> Select Menu Enter Execute Command F10 Save and Exit

Exit Saving Changes

Allows the user to save changes to CMOS and reboot system. The following message
prompts the user to confirm after pressing [Enter] on the item.

Setup Confirmation
Save configuration changes and exit now?
[Yes] [No]

Yes: Exit SETUP and reboot
No: Back to previous screen

Exit Discarding Changes

Allows the user to exit Setup without saving changes to CMOS. The following message
prompts the user to confirm after pressing [Enter] on the item.

Setup Warning
Configuration has not been saved!
Save before exiting?

[Yes] [No]
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Load Setup Defaults

Allows the user loads default values in CMOS Setup. The following message prompts the
user to confirm after pressing [Enter] on this item.

Setup Confirmation
Load default configuration now?
[Yes] [No]

Select Yes to confirm or No to abort. You will then return to the setup screen.

Discard Changes

Allows the user loads previous value in CMOS Setup.

Save Changes

Allows the user to save changes and not exit Setup.
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